
Choose one of the options below to take you to the help information you need.

Contents

How To ... Answers your question "How do I ...?".
Commands How to use the Design Studio menu commands.
Toolbox Description of every Design Studio tool.
Keyboard shortcuts How to use Design Studio with the keyboard.
Glossary Alphabetical list of glossary definitions.

How to choose an option

The topics you can choose are underlined.    Point to the topic you want to choose, and the icon will 
change to a hand when placed over the item.

Use TAB to move the highlight to the topic you want to view, and press ENTER.

For more information on how to use help press F1.



How To ...

These options are groups of explanations of how to do things in Design Studio.

Create pictures
Draw a picture
View a picture
Use templates
Work with objects
Work with points and paths
Work with text
Use lines, fills and colors
Cut, copy, paste and delete objects
Work with graphics
Print the picture

If you are not sure where to find the information you want, then choose Create pictures and use the 
browse function to scan through the list of help topics.



Commands

The topics below offer help on the various menu commands.

File Menu Load and Save, Import and Export, Printing
Edit Menu Undo, Redo, Cut and Paste
View Menu to change the way the picture is displayed in the window
Object Menu to manipulate the shape and arrangement of objects
Line Menu to control line styles, which is the way paths are drawn
Fill Menu to control fill styles, which is the way paths are filled, and to choose and control colors
Help Menu to get help about how to use Design Studio



Tools

Choose the tool for which you require help.

Pointer tool Selecting, dragging, copying
Text tool Entering or editing text objects

Shapes
Box tool Drawing square and rectangular boxes
Round box tool Drawing boxes with rounded corners
Ellipse tool Drawing circles and ellipses
Arc tool Drawing arcs
Pie tool Drawing pie segments
Polygon tool Drawing regular polygons
Star tool Drawing stars

Drawing
Pencil tool Drawing free-form lines
Line tool Drawing straight lines
Curve tool Drawing curve points

Transform
Scale tool Scaling objects
Rotate tool Rotating objects
Skew tool Skewing objects
Reflect tool Reflecting objects

Others
Autotrace tool Tracing imported bitmaps
Magnifier tool Zooming in and out



Keyboard shortcuts

Use the shortcuts for convenience and speed, once you are confident with the functions you are 
performing.

CTRL + F1 means hold CTRL down and then press F1 while still holding CTRL.

Shortcuts using the Function Keys (F1 - F12)
F1 Start the Help facility

SHIFT + F1 Display the pointer so that you can ask for help

F2 Save current picture

F3 Undo last command

F4 Redo last command

F5 Transform again

F6 Switch between outline and preview mode

F7 Display the picture at actual size 

SHIFT + F7 Display the picture in whole page view

F8 Enlarge the picture (to the next standard magnification)

SHIFT + F8 Reduce the picture (to the next standard magnification)

F9 Select the next tool in the toolbox 

SHIFT + F9 Select the previous tool in the toolbox

F10 Pass control to the File menu

Shortcuts using other keyboard keys
RETURN Select the pointer tool

SPACE De-select all points (leaves paths selected)

ESC De-select all selected objects

DEL Delete the selected objects

BACKSPACE Delete the selected points on paths

Cursor keys Scroll the current window in the direction of the arrow (up, down, left or 
right)

PgUp/PgDn Scroll the window up/down by a page

CTRL + PgUp/PgDn Scroll the window left/right by a page

TAB Select next object

SHIFT + TAB Select previous object

Other menu command shortcuts
ALT + A Select all the objects in a picture

CTRL + A Display the Align dialog box

CTRL + B Move the selected objects to the back of the picture

CTRL + C Copy the selected objects to the clipboard without removing them from the



picture

CTRL + F Move the selected objects to the front of the picture

CTRL + G Group the selected objects

CTRL + I Display the dialog box of information about the selected object

CTRL + J Join two end points, or join text to a path

CTRL + S Split a path at the selected points

CTRL + U Ungroup the selected group

CTRL + V Paste the cut or copied objects from the clipboard into the picture

CTRL + X Cut the selected objects from the picture to the clipboard

Text editing shortcuts
These shortcuts are available only when the text tool is selected and the text cursor is placed within a 
text object.

ALT Rotate the text cursor clockwise or counter-clockwise to type text at an 
angle

RETURN Insert a line break

SPACE Insert a space character

ESC De-select any text selection and make the text cursor return to an upright 
position if it has been rotated

DEL Delete the text selection or character to the right of the text cursor

BACKSPACE Delete the text selection or character to the left of the text cursor

Left and right arrows Move the text cursor left or right one character, or, when there is a text 
selection, move the cursor to the start or end of the selection and de-
select the text

Up and down arrows Move the text cursor up or down one line

SHIFT + click Select the text between the text cursor and the position of the click



File Menu Commands

New
Open a new picture.    Opening a new picture causes Design Studio to close any other picture you have 
open, after asking if you want to save changes.    When you load Design Studio, a new picture is opened
automatically.

Open
Display the Open dialog box, which is used to open an existing picture. 

Save
Save the current picture without changing its filename.    If the picture is untitled, the Save As dialog box 
is displayed and you must enter a name for the picture (See Save As below).    The picture remains 
displayed on the desktop for further editing.

Save As
Name a new picture or change the name of a picture before you save it.    The Save As command 
displays the Save As dialog box.

Import
Import a picture file or image into your picture.    The Import command displays the Import from File 
dialog box.

Export

Save all or part of a picture in a variety of formats.    The file can then be imported into other pictures or 
applications, e.g. desktop publishing applications such as 1st Press.    Export    displays the Export to 
File dialog box. 

Page Format
Choose the page format for your picture.    The Page Format dialog box will be displayed.

Print
Display the Print Options dialog box, which allows you to make several choices about how your picture 
is printed.

Printer Setup
Choose which printer your picture is printed on and control the printer's settings.    The Printer Setup 
dialog box is displayed. 

The four "menu commands" below Printer Setup are the filenames of the four most recently opened 
pictures.    To open one of these pictures, click on its filename.    The picture will be displayed in the 
Design Studio window, which causes any other picture you have open to be closed.

Exit
Quit Design Studio.    If there is an open picture with unsaved changes, a message will be displayed 
giving you the option of saving the picture before you quit.



Edit Menu Commands

Undo
Undo the last operation.    You can undo up to fifty operations.

Redo
Redo the previous undo.    You can redo up to fifty undos.

Cut
Remove the selected object or objects from the picture and put them on the clipboard.    The object can 
then be replaced using the Paste command.    Cut is available only if there are objects selected.

Copy
Copy the selected object or objects to the clipboard without removing them from the picture.    Copy is 
available only if there are objects selected.

Paste
Put the contents of the clipboard into the picture.    You can repeatedly paste the same contents from the
clipboard until you cut or copy a new object.    Paste is available only if there is something in the 
clipboard.

Select All
Select all the objects in the picture.

Transform Again
Repeat the last transformation which was performed.    The transformation is performed on the currently 
selected objects.    If the transformation created a copy of the original object, repeating it will also create 
a copy.

Blend
Blend between selected closed paths.    Any applied line styles, fill styles and colors will be blended 
between the paths.    Blend displays the Blend dialog box, and is available only when two closed paths 
are selected.



View Menu Commands

These commands enable you to change the view size of your picture and the way it is displayed.    You 
cannot undo or redo commands in the View menu. 

Preview
Switch between preview mode and outline mode. 

Pictures displayed in preview mode will include all applied line styles, fill styles and colors.    A 
picture will take longer to be redrawn when it is displayed in preview mode.

Pictures displayed in outline mode will represent all objects in the same thin line style without any 
applied line styles, fill styles or colors.

Monochrome
Determine whether a picture displayed in preview mode has its colors displayed in color or in 
monochrome.    This lets you see the relative gray values of the colors, as they would be printed on a 
monochrome printer. 

Actual Size
Display the picture at its actual size.

Whole Page
Display the picture so that the whole page is in view.

Enlarge
Display a magnified view of the picture.

Reduce
Display a reduced view of the picture.

Color Palette
Display a palette of colors at the bottom of the Design Studio desktop.    The palette remains on the 
desktop until you close it. 

Info Line
Switch between displaying and not displaying the information line at the bottom of the desktop.

Show Rulers
Switch between displaying and hiding the rulers. 

Grid
Display the Grid dialog box.    A grid can help you align objects and judge their size.    The grid does not 
form part of your picture and is not printed.



Object Menu Commands
For each operation in this menu, one or more objects of the appropriate type must be selected.    A 
command will be grayed out if the appropriate selection has not been made.

To Front
Move the selected object or objects to the front of the picture.

To Back
Move the selected object or objects to the back of the picture. 

Group
Combine the selected objects into a group.    You can then manipulate all the objects together as a 
single object.    A group can be included as part of another group; this is known as "nesting".

Ungroup
Separate a group of objects into its components.    The exact operation of the command depends on the 
type of the selected object:

Join
Join two objects together.    The exact operation of the command depends on the type of objects you 
have selected:

When the end points of open paths are selected and within the join range, Join joins the end 
points together

When a text object and a path are selected, Join joins the text to the path

Split
Break a path at the selected point.    If you have selected text on a path, the Split command separates 
the text from the path. 

Align
Align selected objects to each other or to the page.    The Align command displays the Align dialog box.

Info
Display a dialog box providing information about the selected objects.    Some of the information    can be
changed, and this depends on the objects which are selected.    For more information, refer to:

Shape Info dialog box
Path Info dialog box
Spacing dialog box
Text on a Path dialog box

Multiple Objects dialog box

Image dialog box

Group of Objects dialog box



Line Menu Commands

These commands enable you to apply line styles to objects in your picture.

When you select or create a line style with no object selected, that line style will become the default for 
objects created from then on.

Popup Lines
Display the Line Style dialog box.    This dialog box allows you to create new line styles by setting the 
features of the line.    In this dialog box, you can give the line a width, and specify whether it is to be 
solid, dashed or not shown.    You can also choose a color for the line, and specify any arrowheads 
which are to be shown at the ends of the line.

None
Turn off the line style of the selected object so that it has no outline.    This command is marked with a 
check when the selected object has no line style.

Solid
Give the selected object a solid outline.    This command is marked with a check when the selected 
object has a solid outline.

Dashed
Give the selected object a dashed outline.    When you select this command, you are given a choice of 
four dashed styles.    This command is marked with a check when the object has a dashed outline.

Hairline
Give the selected object a very fine outline.    This command is marked with a check when the object has
a hairline width outline.

1pt
Give the object an outline of 1pt width.    This command is marked with a check when the object has a 
1pt outline.

Width
Give a choice of six line widths: 2, 3, 4, 6, 9 or 12 pt.    This command is marked with a check when the 
object is outlined with one of these line widths.

Color
Display the color palette.    Click on a color within the palette to assign that color to the outline of the 
selected object.

Ends
Display the Line Ends dialog box.    Choose an arrowhead design for each end of the line.    Choose one 
of three end styles for the line: butt, round and square.    Choose one of three join styles: miter, round 
and bevel.



Fill Menu Commands

These commands enable you to apply fill styles to objects in your picture.

Popup Fills
Display the Fill Style dialog box.    This allows you to create new fill styles by setting the features of the 
fill.    You can specify which type of fill is to be used (none, plain or one of four graduated styles) and 
which color is to be used.

None
Turn off the fill style of the selected object so that the selected object has no fill style.    This command is 
marked with a check when the selected object is not filled.

Solid
Give the selected object a solid fill style.    This command is marked with a check when the object has a 
solid fill style.

Linear
Give the selected object a linearly graduated fill style.    This command is marked with a check when you
have chosen a linear fill style.

Logarithmic
Give the selected object a logarithmically graduated fill style.    This command is marked with a check 
when you have chosen a logarithmic fill style.

Radial
Give the selected object a radially graduated fill style.    This command is marked with a check when you
have chosen a radial fill style.

Spherical
Give the selected object a spherically graduated fill style.    This command is marked with a check when 
you have chosen a spherical fill style.

Color
Display the color palette.    Click on a color within the palette to give that color to the selected object.

To Color
If you have chosen a graduated fill style, this option will be available.    It displays the color palette.    
Click on it to select the color to which the original color will change during the graduation.      



Help Menu Commands

Contents
Choose Contents to display a list of topics for which you can get help.

Using Help
Choose Using Help to display information about how to use Windows help.

Pointer
Choose Pointer to obtain the help pointer which you can click on any area of the Design Studio desktop
to get help about it.





Open dialog box

Choose and open a picture that has already been created in Design Studio so that you can continue to 
work on it.

File Name list box
Select the file you want to open.

List Files of Type drop-down list box
Select the type of file you want to open by clicking on Picture or Template.    Files of the selected type in
the current directory are displayed in the File Name list box. 

Directories list box
Displays all the directories in the path from the root to the current directory, and a list of all directories 
contained in the current directory.    Click on any directory to select it; click on it again to make it the 
current directory. 

Drives drop-down list box
Select a different disk drive.    Click on the arrow at the right-hand side of the Drives list box to display all
the disk drives available.    If necessary, use the scroll bar to scroll through the list of drives and select 
the one you want.



Save As dialog box
Save a picture with a new name, or in a different directory or disk.

File Name list box
Type in a file name for the picture you want to save.

Save File as Type drop-down list box
Select the file type you want to save your picture as by clicking on Picture or Template.    Files of the 
selected type in the current directory are shown grayed out in the File Name list box; Design Studio 
warns you if you try to overwrite an existing file. 

Directories list box
Lists all the directories in the path from the root to the current directory, and a list of all directories 
contained in the current directory.    Click on any directory to select it; click on it again to make it the 
current directory. 

Drives drop-down list box
Select a different disk drive.    Click on the arrow at the right-hand side of the Drives list box to display all
the disk drives available.    If necessary, use the scroll bar to scroll through the list of drives and select 
the one you want.



Export to File dialog box

File Name list box
Displays all files of the selected type in the current directory.

List Files of Type drop-down list box
Select the type of file you want to export your picture as.    

Directories list box
Displays all the directories in the path from the root to the current directory, and a list of all directories 
contained in the current directory.    Click on any directory to select it; click on it again to make it the 
current directory. 

Drives drop-down list box
Select a different disk drive.    Click on the arrow at the right-hand side of the Drives list box to display all
the disk drives available.    If necessary, use the scroll bar to scroll through the list of drives and select 
the one you want.

Monochrome
Select this if you are exporting a color picture but want the colors to be converted into shades of gray in 
the exported file.    This is required for some printing processes. 

All Objects
Available if you selected an object before displaying the Export to File dialog box.    To export only the 
selected objects, do not select the All Objects option; to export the whole picture, select the All 
Objects option. 

Resolution
If you have chosen to export the picture in a bitmap file format, you can specify the resolution of the file.  
Click in the box and type in the resolution.    (Minimum resolution 10 dots per inch, maximum 1000 dots 
per inch.)



Import from File Dialog box

Import a line-art or image file for incorporation into your picture.

File Name list box
Select the file you want to import.

List Files of Type drop-down list box
Select the type of file you want to open.    Files of the selected type in the current directory are displayed 
in the File Name list box. 

Directories list box
Displays all the directories in the path from the root to the current directory, and a list of all directories 
contained in the current directory.    Click on any directory to select it; click on it again to make it the 
current directory. 

Drives drop-down list box
Select a different disk drive.    Click on the arrow at the right-hand side of the Drives list box to display all
the disk drives available.    If necessary, use the scroll bar to scroll through the list of drives and select 
the one you want.

Smoothing
Select this if you are importing a line-art file which you would like to have smoothed.    Some line-art files
represent curves with a series of short straight lines; smoothing the line-art file will smooth these straight
lines into curves, making the image clearer.    The Smoothing check box is enabled (available for 
selection) only when you import a line-art file.



Page Format dialog box

Specify the page size and related attributes for your picture; delete page sizes you do not want to use.

Page Sizes list box
Select an existing page size.

Custom page group box
Create a new page size or delete a selected size:

specify Height and Width (values must be less than 24 inches).    You can change the units in the
Units drop-down list box. 

Add button: add a new page size to the list in the Page Sizes list box. You must enter a name for 
the new page size at the top of the Page Sizes list box before the Add button becomes available.

Delete button: delete a selected page size.    The page size is then removed from the list of 
available sizes.    You cannot delete any of the pre-defined page sizes.

Picture Orientation
Select Portrait (vertical) or Landscape (horizontal).



Print Options dialog box

Print a picture onto paper or to a file.

Output group box
Displays the currently selected printer. 

Print to Disk option: print your picture to disk so that it can be printed at a later date.    When you 
click on OK with the Print to Disk option selected, the Print to Disk dialog box is displayed.

Copies box: enter the number of copies you want to print.    The paper size and the picture size 
are displayed on the right, to indicate whether you should scale the picture to match the paper size.    
When the picture (page) size is in landscape format, [Lan] will appear after the picture (page) size.

Change Printer button: change the settings of the current printer or select an alternative printer.   
Clicking on Change Printer displays the Printer Setup dialog box, which is also displayed by clicking on 
the Printer Setup command.

Flip Orientation button: 'flip' the orientation of the picture at the printing stage without 
transforming the picture.

Tiling group box
Use tiling if your picture is larger than the paper size.

For example, your picture might be Legal but the paper size only Letter.    If Allow Tiling is 
selected, Design Studio will divide your picture into portions (or tiles) and print each portion on a separate 
page.    No. of Pages shows how many sheets of paper your picture will be printed on when it is tiled. 

Scale group box

 % box: enter a scaling value or use the arrows to select the value you want.    When the picture is
scaled, it is scaled by the same amount in both dimensions.

Fit Page button: If your picture is larger or smaller than the paper you are printing on, select this 
to scale the picture so that it fits the paper size.    If your picture is larger than the paper, the picture will be
scaled down; if your picture is smaller than the paper, your picture will be scaled up.

100% button: select this to make your picture print at its actual size; you may need to use tiling to 
print the whole picture if your picture is larger than the paper size. 

Options group box

Crop marks/registration marks: click to print these.

Halftone Screen: available only if you are printing to a non-PostScript printer or a non-color 
printer.    Prints colors on a monochrome printer as gradual grayscales, to produce a better contrast 
picture.

Reversed (mirror image): If a PostScript printer is selected, you can choose to print the picture 
as a mirror image.



Negative (white-on-black): If a PostScript printer is selected, you can choose to print the picture 
as a negative image.    If you are printing to film you will probably need to print a negative; if printing to 
paper you probably need a positive.



Print to Disk dialog box

Select a file to print to, instead of printing your picture on paper.

File Name list box
Select the file you want to print to.

Save File as Type drop-down list box
Select the type of file you want to print to by clicking on Printer file or PostScript file.    A PostScript file 
should have the .EPS file extension; use the .PRN file extension for other printer types.    Files of the 
selected type in the current directory are displayed in the File Name list box.

Directories list box
Displays all the directories in the path from the root to the current directory, and a list of all directories 
contained in the current directory.    Click on any directory to select it; click on it again to make it the 
current directory.

Drives drop-down list box
Select a different disk drive.    Click on the arrow at the right-hand side of the Drives list box to display all
the disk drives available.    If necessary, use the scroll bar to scroll through the list of drives and select 
the one you want.



Printer Setup dialog box

Select a printer by highlighting its name in the list box.    This dialog box can be reached directly from the
File menu or via the Print dialog box.

Setup: display the printer setup dialog box.    These dialog boxes originate from the printer drivers
and are specific to the selected printer, although they all have a similar format.



Blend dialog box

Control the stages in a blend operation.

No. of Blend stages
Enter the number of intermediate stages required.

First Stage and Last Stage
Adjust the values as required.    These values control by how much the object is transformed at the first 
and last blend stages respectively, i.e. the proportion of the transformation done in these steps.    The 
default values depend on the number of blend stages chosen and are calculated so that the blend will 
be even and gradual.



Grid dialog box

Show Grid
Display the grid on the desktop.

Snap control
Insure that objects align with the grid when they are drawn, moved or sized.

Align to page
Align the grid to the top left-hand corner of the page.

Align to Ruler
Align the grid to the ruler origin.    If the ruler origin is at the top left-hand corner of the page, Align to 
Ruler will be disabled (not available for selection).

Units drop-down list box
Select a unit of measurement for the grid.    The grid units can be different from the ruler units.    

Spacing group box
Enter the width and height of each grid cell.    You can specify how many sub-divisions there are across 
and down each cell.    Clicking on the Copy button will copy the horizontal settings to the vertical settings
to give a square grid. 



Align dialog box

Align objects with each other or with the page.    You can align a number of objects to the left, center or 
right, and to the top, middle or bottom.    A sample box shows how the alignment will take effect.

Each other or Page
Select whether objects are aligned with each other or with the page. 

Horizontal group box
Option buttons enable alignment to Left, Center or Right, or none. 

Vertical group box
Option buttons enable alignment to Top, Middle or Bottom, or none.



Shape Info dialog box

Gives information about basic shapes and enables you to change some of their attributes.

Shape group box

Shape shows the current shape of the object and allows you to change it with the drop-down list 
box.

Corner radius: available when the shape is a round box; it allows you to change the corner 
radius of the box.

Sides: available when the shape is a polygon; it allows you to change the number of sides of the 
polygon.

Points: available when the shape is a star; it allows you to change the number of points of the 
star.

Inner Radius: available when the shape is a star; it allows you to specify how pointed the star is.

Start Angle and End Angle: available when the shape is an arc or a pie slice; they allow you to 
change the appearance of the shape by altering its angles.

Position group box
Use this box to specify exactly where the object should appear in the picture.    You can specify the 
position of the left, center or right of the object in the horizontal dimension, and the top, middle or bottom
in the vertical dimension.    Click on the drop-down menus to change the entry.    The coordinates are 
specified from the ruler origin.    When you click on OK, the object moves to the position you specified.

Size group box
Displays the shape's dimensions.

Units drop-down list box
Select a unit of measurement for the shape.



Group of Objects dialog box

Objects group box
Displays the number of objects in the group.

Position group box
Use this box to specify exactly where the group should appear in the picture.    You can specify the 
position of the left, center or right of the group in the horizontal dimension, and the top, middle or bottom
in the vertical dimension. The coordinates are specified from the ruler origin.    When you click on OK, 
the group moves to the position you specified.

Size group box
Displays the group's dimensions.

Units drop-down list box
Select a unit of measurement for the group.



Object Info (Image) dialog box

Gives information about imported elements and enables you to change some of their attributes.    The 
exact title of the dialog box and the name of the first group box depend on the type of element selected.

Bitmap/PostScript group box

Filename identifies the file source of the object.

Size in pixels: shows the size of the object.

No of colors box: shows how many colors there are in the object.

Negative check box: select this to invert the object's colors.

Position group box
Use this box to specify exactly where the object should appear in the picture.    You can specify the 
position of the left, center or right of the object in the horizontal dimension, and the top, middle or bottom
in the vertical dimension. The coordinates are specified from the ruler origin.    When you click on OK, 
the object moves to the position you specified.

Size group box
Displays the image's dimensions.

Units drop-down list box
Select a unit of measurement for the image.



Path Info dialog box

Gives information about the selected paths and enables you to change some of their attributes.

Path group box

Contours indicates how many contours the path consists of.

Path Closed check box: check this to close an open path.

Winding Fill check box: use this to select a winding fill when filling a compound path.

No Points Selected group box
Indicates how many points of which types are selected, and whether the path has auto curvature.    
Turning Auto curvature off enables you to edit points without the path being constrained by Design 
Studio's automatic curvature. 

Position group box
Use this box to specify exactly where the object should appear in the picture.    You can specify the 
position of the left, center or right of the object in the horizontal dimension, and the top, middle or bottom
in the vertical dimension.    The coordinates are specified from the ruler origin.    When you click on OK, 
the object moves to the position you specified.

Size group box
Displays the path's dimensions.

Units drop-down list box
Select a unit of measurement for the path.



Text on a Path dialog box

Gives information on a text object joined to a path, and allows you to change some of its attributes.

Options group box

Show Path: check this to include the path in the picture as well as the text joined to it.

Joined: de-select this to split the object back into its separate path and text objects.

Reverse Direction: check this to reverse the direction of the text along the path.

Separate: check this to separate the text from the path, for example prior to splitting the path

Align text to path using group box

Top: produces the effect of the characters hanging down from the path.

1/2 Cap-height: produces the effect of the path running through the middle of the characters.

Baseline: (the default alignment) aligns the text baseline to the path.

x-height: aligns the text to the path at the height of a lower-case x character.

1/2 x-height: aligns the text to the path at half the height of a lower-case x character.

Descender: produces the effect of text standing on the path on the descenders of letters such as 
g and y.

Text Orientation group box

Rotate baseline: (the default orientation) the characters are perpendicular to the path.

Skew baseline: the vertical elements of the characters remain vertical while the horizontal 
elements are parallel to the path.

Upright: each character is upright.

Skew vertical: the horizontal elements of the characters remain horizontal while the vertical 
elements are at right angles to the path.

Edit Text
Open the Spacing dialog box to make other changes to the spacing of the text.

Path Info
Open the Path Info dialog box for the path to which the text is joined.



Spacing dialog box

Set parameters controlling the spacing of letters, words and lines of a text object.

All the options in this dialog box can be changed by typing in the appropriate box, or by using the arrows
to scroll to the value you require.

Leading box
Adjust the space between the lines of text. 

Word Space boxes
Set the maximum and minimum spacing between the words in the text.

Letterspace boxes
Set the maximum and minimum spacing between the letters in the text. 

Reset
Set all the values back to their defaults.



Multiple Objects dialog box

This dialog box appears when more than one object is selected.    It tells you how many objects are 
selected.



Rounded Box dialog box

Set the default corner radius to be used for future round boxes.

Type the corner radius required into the Default Corner Radius box. You can select the unit of 
measurement from the Units drop-down list box. 

A small corner radius will result in a box with slightly rounded corners; a large corner radius will 
result in a box with very rounded corners.

To change the corner radius of an existing round box, double-click on the round box and select 
Object Info to call up the Shape Info dialog box.    You can then change the corner radius.    



New Color dialog box

Add a color to the color palette.

All colors are made up of red, green and blue.    Move the sliders next to these colors to create a color.    
The color is shown in the display box.

Click on the eight color boxes around the display box to obtain certain colors.    For example, click on the
red box to make your color more red.

Click on OK to add the color to the palette.

If you have an object selected when you create a new color, that color will automatically be given 
to the selected object.



Reflect dialog box

Reflect an object  or objects across a mirror line (reflection axis).

Reflect across group box
Select the axis that you want the object to be reflected across.    This can be a Vertical or Horizontal 
axis, or, if you select Angled Axis, you can specify any other angle either by typing in the box provided 
or by clicking on the wheel.

Fixed Point group box
Specify where the fixed point should be.    Select an option button to determine how the fixed point 
should be located.

Mouse Click uses the point where you double-clicked to call up the dialog box.

Center of Selection places the fixed point in the middle of the selected objects, allowing you to 
reflect exactly around the middle.

XY Location lets you specify the exact position of the fixed point in the Across and Down boxes.

Units drop-down list box
Select a unit of measurement for the reflection.

Copy Objects check box
Click on this if you want to transform a copy of the selected object while leaving the original unchanged.



Rotate dialog box

Rotate an object accurately.

Rotation group box
Specify the angle of rotation.    You can type the angle into the Angle box, use the arrows to increase or 
decrease the value, or drag the radius in the circle.

Fixed Point group box
Specify where the fixed point should be.    Select an option button to determine how the fixed point 
should be located.

Mouse Click uses the point where you double-clicked to call up the dialog box.

Center of Selection places the fixed point in the middle of the selected objects, allowing you to 
tilt or rotate exactly around the middle.

XY Location lets you specify the exact position of the fixed point in the Across and Down boxes.

Units drop-down list box
Select a unit of measurement for the rotation.

Copy Objects check box
Click on this if you want to transform a copy of the selected object while leaving the original unchanged. 



Skew dialog box

Skew objects precisely.

Skew group box
Set the Horizontal and Vertical skew factors.

Fixed Point group box
Specify where the fixed point should be.    Select an option button to determine how the fixed point 
should be located.

Mouse Click uses the point where you double-clicked to call up the dialog box.

Center of Selection places the fixed point in the middle of the selected objects, allowing you to 
skew exactly around the middle.

XY Location lets you specify the exact position of the fixed point in the Across and Down boxes.

Units drop-down list box
Select a unit of measurement for the reflection.

Copy Objects check box
Click on this if you want to transform a copy of the selected object while leaving the original unchanged.



Scale dialog box

Change the size of objects accurately.

Scaling group box
Select Uniform to scale equally in vertical and horizontal directions.    Choose the percentage by which 
you want to scale the object.    Select Non Uniform to scale an object differently in vertical and 
horizontal directions.    You can then set the vertical (Y) and the horizontal (X) factors separately.

Fixed Point group box
Specify where the fixed point should be.    Select an option button to determine how the fixed point 
should be located.

Mouse Click uses the point where you double-clicked to call up the dialog box.

Center of Selection places the fixed point in the middle of the selected objects, allowing you to 
scale from the center.

XY Location lets you specify the exact position of the fixed point in the Across and Down boxes.

Units drop-down list box
Select a unit of measurement for the reflection.

Copy Objects check box
Click on this if you want to transform a copy of the selected object while leaving the original unchanged.



Move Objects dialog box

Move an object by a specific amount in a specific direction (you may find that dragging is not accurate 
enough). 

Horizontal group box
Move the object to the left or the right.

Vertical group box
Move the object up or down.    By combining a horizontal shift with a vertical shift, you can move the 
object in any direction.

Units drop-down list box
Select a unit of measurement for the movement. 

Copy Objects check box
Click on this if you want to move a copy of the object while leaving the original unchanged.



Freehand dialog box

Adjust the accuracy with which a path follows the movements of the pencil tool.

Use the arrows to change the smoothness value; this determines how close together points will 
be placed on the path. 

A smoothness value of 1 means points can be placed very close together; the path can therefore 
change direction many times in a short distance and so will be "rough". 

A smoothness value of 9 means that points cannot be as close together; the path cannot change 
direction as many times and so will be smoother.



Autotrace dialog box

Adjust    the accuracy of the autotrace tool.

Increasing the smoothness value draws a smoother path which does not follow the small scale 
irregularities of the original. 

Decreasing the smoothness value makes a more complex path which follows the original more 
closely.



Line Style dialog box

Specify the line style of the line you have selected, or any lines you draw in the future.

Three sections of line
Set a separate style for the left end, body and right end of the line.    Click on the section you require to 
see the options.    Each end can have one of eleven styles, including different arrowheads.    The body 
can have one of six styles: no line, solid line, or four types of dashed line.

Thickness bar
Drag the slider along the scale to alter the thickness of the line.    The thickness is given in figures in the 
box below: you can type directly into this box to obtain an accurate thickness.

Color box
Click on the down arrow to display the color palette, and select the color you require.

Ends drop-down list box
Choose one of three end styles: butt, round and square.

Join drop-down list box
Choose one of three join styles: miter, round and bevel.

As you specify aspects of the line, the three section boxes act as a preview box to display the line you 
have set.

When you are happy with all your choices, click on Apply to apply the chosen line style to the previously
selected object.

This dialog box can be left open on the desktop if you prefer.    To close it, either click on the Line Style 
button in the shortcuts, or click on the control-menu box.

Once you have set a line style, this will be used as the default for any subsequent lines you draw, 
until you use the Line Style dialog box again and change the settings. 



Fill Style dialog box

Specify the fill style of the object you have selected, or any objects you draw in the future.

Fill style list
Choose one of six fill styles: none, plain, linear, logarithmic, radial or spherical.

Preview box
Displays the fill style you have chosen.    If you have chosen a linear fill style, an arrow indicates the 
direction of the fill.    To change the direction, drag the arrow.

Color box
Click on the down arrow to display the color palette, and select the color you require.

To color box
If you have chosen one of the four graduated fill styles, a second color box is shown.    Click on the down
arrow to display the color palette, and select the "to color" you require.

When you are happy with all the choices, click on Apply to apply the chosen fill style to the previously 
selected object.

This dialog box can be left open on the desktop if you prefer.    To close it, either click on the Fill Style 
button in the shortcuts, or click on the control-menu box.

Once you have set a fill style, this will be used as the default for any subsequent objects you 
draw, until you use the Fill Style dialog box again and change the settings. 



Polygon dialog box

Specify the number of sides which future polygons are to have.    Type in the number you require, or use
the arrow buttons.    A sample polygon is shown in the preview box.

To change the number of sides of an existing polygon, double-click on the polygon and select Object 
Info to display the Shape Info dialog box.    You can then change the number of sides.



Star dialog box

Specify the number of points which future stars are to have.    Type in the number you require, or use the
arrow buttons.    You can also determine how pointed the star is to be by altering the inner radius; you 
can do this either by typing in a figure, or by dragging the slider bar.    A sample star is shown in the 
preview box.

To change the number of points and the inner radius of an existing star, double-click on the star and 
select Object Info to display the Shape Info dialog box.    You can then change the number of points 
and the inner radius.



Line Ends dialog box

Specify the way the ends of the selected line, and any subsequent lines, are to be displayed.

Arrowheads drop-down list boxes
Choose one of ten arrowhead styles for the left and right ends of the line.    You can also choose a plain 
end style.

Ends drop-down list box
Choose one of three end style for the line: butt, round and square.

Join drop-down list box
Choose one of three join styles for the line: miter, round and bevel.



Edit Color dialog box

Edit a color in the color palette.

The selected color is shown in the display box.    Move the red, green and blue slider bars to change the 
color.

You can also click on the eight color boxes around the display box to obtain certain colors.    For 
example, click on the red box to make your color more red.

Click on OK to add the color to the palette in place of the color you originally chose.

If you have an object selected when you edit a color, the edited color will automatically be given 
to the selected object.

Any objects already using the color you have edited will be re-colored with the new color you 
have created.



Text Info dialog box

Edit the selected text object.

Text group box
Click on the Spacing button to display the Spacing dialog box.

Position group box
Use this box to specify exactly where the text object should appear in the picture.    You can specify the 
position of the left, center or right of the text object in the horizontal dimension, and the top, middle or 
bottom in the vertical dimension.    Click on the drop-down menus to change the entry.    The coordinates 
are specified from the ruler origin.    When you click on OK, the text object moves to the position you 
specified.

Size group box
Displays the text object's dimensions.

Units drop-down list box
Select a unit of measurement for the text object.
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Design Studio Glossary

Choose the term you need to be defined.    Click and hold the mouse button while the definition is 
displayed. 

-A-
align to page
align to rulers
align 
arc
arrowhead
attributes
auto curvature
autotrace
axis

-B-
background
basic shape
bevel
bitmap
blend 
blend stages
box
butt

-C-
check box
clipart
clipboard
closed path
color palette
control lines
control menu
control points
convert to path
copy
corner point
corner radius
crop marks
curve point
custom page
cut

-D-



default
desktop printer
dialog box

-E-
ellipse
ends
EPSF
export

-F-
file
file extension
fill style
first point
fixed point
floating toolbox
font
foreground
freehand drawing

-G-
grayed out
greeking
grid
group

-H-
hairline
handles

-I-
image
imagesetter
import
information line
intersection area

-J-
join
justification

-K-
kerning
keyboard alternatives
keyboard shortcuts

-L-
landscape



leading
letter spacing
line-art
line style
linear
list box
logarithmic

-M-
magnification
metafile
mirror line
miter

-N-
negative

-O-
object
open path
outline format

-P-
page box
paste
path
PCX
pica
pie slice
pixel
point
polygon
portrait
preview format
preview box
printable area
printing to disk

-R-
radial
redo
redraw
reference points
reflection axis
registration
registration marks
reversed



RGB
rotate
round box
round
ruler
ruler origin

-S-
scale factor
scaling (printing)
scanner
select
selection frame
selection range
shortcuts
skew
snap control
spherical
split path
square
standard view size
star

-T-
template
text controls
text frame
text object
text on a path
TIFF
toolbox
trace
tracking
transform
typeface

-U-
undo
ungroup

-V-
vector font
vector-based
view size

-W-
work area





Align to page
A setting to make the grid align to the top left-hand corner of the page.



Align to rulers
A setting to make the grid align to the ruler origin.



Align
The positioning of objects with respect to each other or to the page.



Arc
A curve which is part of the circumference of an ellipse.



Arrowhead
An arrow symbol which you can select for the ends of a line style.



Attributes
The line styles and fill styles given to objects.



Auto curvature
The production of a smooth curve through a point that depends on the position of adjacent points.    A 
point has auto curvature when it is created.



Autotrace
Automatically trace an outline around an imported image.



Axis
The line in which objects are reflected in a reflect transformation.    The reflection axis passes through 
the fixed point.



Background
The unset bits in a monochrome bitmap image.



Basic shape
A box, round box, ellipse, arc, pie slice, polygon or star, created with one of the shape tools.



Bevel
A style of line join in which the corner is cut off.



Bitmap
A graphic made up of a pattern of dots.    Paint packages and scanners produce these images.



Blend
The insertion of intermediate paths between two paths or basic shapes, with a transition of line styles 
and fill styles from one end to the other.



Blend stages
One of the intermediate paths inserted between two paths or basic shapes during a blend operation.



Box
A rectangle or square drawn using the box tool.



Butt
A squared-off end type for a line style, which does not project beyond the end of the line.



Check box
A standard Windows control element allowing selection and de-selection of an option independent of the
settings of other options.



Clipart
Files, usually graphics, imported into an application to provide ready-made components of pictures.



Clipboard
A mechanism provided by Windows for transferring data within and between applications.    The Cut and 
Copy commands transfer data to the clipboard.    The Paste command can then be used to transfer the 
data from the clipboard to another location in the same or another application.



Closed path
A path with no end points.    Closed paths can be filled.



Color palette
A set of colors along the bottom of the Design Studio desktop.    Click on a color to apply it to the 
currently selected object.    You can add colors to the palette.



Control lines
Lines used to connect control points to points on paths.    The length and direction of the control lines 
control the direction and curvature of the path at the point.



Control menu
A standard Windows menu displayed by clicking on the bar-shaped icon at the top left-hand corner of 
any window.



Control points
+ shaped handles at the end of control lines.    The handles are dragged to change the length and 
direction of the lines.



Convert to path
An operation used to change basic shapes and text objects into paths.



Copy
A command used to transfer a copy of an item to the clipboard without removing the original.



Corner point
The type of point used to connect straight sections of a path.



Corner radius
The radius used to create the corner of a round box.



Crop marks
Hair lines drawn on a printout to mark the edge of the picture when the printout is tiled or printed on 
paper larger than the picture.



Curve point
The type of point drawn by the curve tool to connect curved sections of a path smoothly without a 
corner.



Custom page
A page size defined by you on the Page Format dialog box.



Cut
A command used to remove an object from a picture and transfer it to the clipboard.



Default
What the computer does unless you tell it otherwise.



Desktop printer
A printer connected directly to your computer.



Dialog Box
A window used to supply information to Design Studio.



Ellipse
A regular oval drawn using the ellipse tool.    The most regular oval is the circle.



Ends
A component of line style allowing the ends of an open path to be made round, square or butt.



EPSF
Encapsulated PostScript Format - a line-art format that Design Studio can handle.



Export
Save part or all of a picture in one of a number of file formats used by other applications.



File
A document stored on a hard or floppy disk.



File extension
The three letters after the dot in a    filename.



Fill style
The attribute of closed paths, text objects and basic shapes specifying how the space enclosed by their 
outlines should be filled.    Fill styles can have different colors, and can be plain or graduated from one 
color to another in a number of different styles. 



First point
The point on a path or basic shape which used as the reference point for a blend if no points are 
selected.



Fixed point
Scale, rotate, reflect and skew transformations are performed about the fixed point.



Floating toolbox
The optional display of the Design Studio tools in a moveable window.



Font
This is used in Design Studio to mean the style of type e.g. Courier, Helvetica, or Times Roman.    
Elsewhere this may be called a typeface, with the term font reserved for a particular weight, size and 
style of a typeface.



Foreground
The set pixels of a bitmap image.



Freehand drawing
A drawing made up of paths drawn by dragging with the pencil tool.



Greeking
The representation of text by simple strokes.



Grayed out
A command shown in gray (rather than black) because it is disabled, i.e. unavailable for use.



Grid
An optional overlay of crossed lines to help accurate positioning of an object in a picture.    Precise 
positioning is assisted by the option of making objects snap to the grid when they are created, moved or 
transformed.



Group
A set of objects grouped together so that they behave as a single object.



Hairline
A line displayed or printed at the finest resolution possible on the particular screen or printer.



Handles
Small shapes, appearing on selected objects.    Handles can be dragged to change the shape of the 
object.



Image
A graphic made up of a pattern of dots (also called a bitmap).    Paint packages and scanners produce 
images.



Imagesetter
An electronic typesetter than can handle graphics as well as type.    Imagesetters typically have a 
resolution of 600 dpi (dots per inch) or better.



Import
Load part of a picture or a piece of clip-art in one of a number of file formats used by other applications.



Information line
A bar at the bottom of the work area giving information and hints on what to do next.



Intersection area
The square at the top left-hand corner of the work area where the horizontal and vertical rulers meet.



Join
(1) A command joining together the open ends of paths or joining text to a path.
(2) A property of a line style specifying how line segments are joined at corner points.



Justification
The layout of text across a text frame or along a path so that it fills the width of the frame or the length of
the path.    Justified text in a text frame will have straight left- and right-hand edges.



Kerning
Reducing the space between characters.    Compare with tracking.



Keyboard alternatives
An alternative to using the mouse for selection.    Keyboard alternatives are shown on screen by 
underlining a letter in menu titles, box names and so on.    There is a keyboard alternative for all mouse 
selection operations.



Keyboard shortcuts
A means of carrying out a command from the keyboard without opening a menu first.    Shortcuts are a 
replacement for several mouse selection operations.    If there is a shortcut, it is shown after the 
command in the menu.    Not all commands have keyboard shortcuts.



Landscape
The orientation of a page in which the horizontal size is greater than the vertical.



Leading
The spacing between lines of text.    The name comes from the use of strips of lead to separate lines in 
traditional printing methods.



Letter spacing
The amount of space automatically inserted between characters, to achieve justified lines.



Line-art
Pictures defined as a series of straight and curved lines rather than dots.    Drawing packages produce 
line-art.    Compare with image.



Line style
The attribute of paths, text objects and basic shapes specifying how the line or outline should be drawn. 
Line styles can have different widths and colors.



Linear
A type of graduated fill style where the color changes smoothly from one end to the other.



List box
A scrollable box displaying a list of options.



Logarithmic
A type of graduated fill style where the color initially changes quickly and then tapers off to a final color.



Magnification
The view size of the picture on the screen.



Metafile
A class of file formats for line-art.



Mirror line
The line in which objects are reflected in a reflect transformation.    The reflection axis passes through 
the fixed point.



Miter
A style of line join in which the lines extend to a point at the join.



Negative
A print option interchanging black and white.



Object
A basic shape, path, text object, imported image or group.



Open path
A path with two separate end points.



Outline format
A simplified picture display allowing rapid redrawing.



Page box
The blue rectangular outline on the work area marking the position of the page, which is specified using 
the Page Format dialog box.



Paste
A command used to copy data from the clipboard to the application.    Items remain on the clipboard 
after they have been pasted. 



Path
A straight or curved line consisting of one or more segments joined together at points.



PCX
A standard file format for images.



Pica
A typesetting unit, equal to 1/6 inch.



Pie slice
A segment of a circle or other ellipse, drawn using the pie tool.



Pixel
A picture element.    One of the dots making up a picture displayed on the screen.



Point
(1) The unit used to measure text: 1 point = 1/72 inch.
(2) The corner and curve points used to define paths.



Polygon
A regular shape with three or more sides, drawn using the polygon tool.



Portrait
The orientation of a page in which the vertical size is greater than the horizontal.



Preview format
A screen display representing the printed form of a picture as closely as possible.



Preview box
A box in some dialog boxes showing the effect of selecting items.



Printable area
The area of the page that the printer can print on, marked by a dashed rectangle.



Printing to disk
Send output for printing to a disk instead of a printer, so that the picture can be printed at another time.



Radial 
A type of graduated fill style made up of circles, with equal graduation intervals from the center to the 
circumference.



Redo
Redo an edit or transformation which has been undone with the Undo command.



Redraw
Re-display parts of the screen which have changed.



Reference points
The points on two objects which are mapped into each other when a blend is made between the two.



Reflection axis
The line in which objects are reflected in a reflect transformation.    The reflection axis passes through 
the fixed point.



Registration
The alignment of the tiles in a tiled picture to make up the complete picture.



Registration marks
Marks on printouts used to assist registration.



Reversed
An option in printing producing a reversed image.



RGB
A color model for additive mixing, in which Red, Green and Blue are mixed to produce any color.



Rotate
A transformation performed with the rotate tool.



Round box
A box with rounded corners.



Round
A type for the Join and Ends properties of a line style.



Ruler
Optionally displayed scales at the top and left-hand side of the work area.



Ruler origin
The point on the desktop which measures zero on both horizontal and vertical rulers.



Scale factor
The percentage by which a scaling operation changes the size of a picture or selected objects.    There 
may be different scale factors for the vertical and horizontal directions.



Scaling (printing)
The application of a scale factor to change the size of a picture when it is printed.



Scanner
A device used to convert an image on paper to an image in a computer.



Select
(1) Choose an object on which your next action will be carried out.
(2) Choose a command, option button or check box.



Selection frame
A rectangle dragged out with the pointer tool to select any item in the rectangle when the mouse button 
is released.



Selection range
The distance around the pointer tool within which an object will be selected if the mouse button is 
clicked.



Shortcuts
Buttons which perform particular common operations, such as Cut, Copy, Paste and Transform Again.    
Click on a shortcut button to perform the action.    The shortcut buttons can be attached to any edge of 
the desktop, or they can be displayed in a floating box.    



Skew
A transformation performed using the skew tool.



Snap control
Force objects to align to the grid.



Spherical
A type of graduated fill style made up of circles, with increasing graduation intervals from the center to 
the circumference.



Split path
Break a path at a point.    An open path is split into two shorter open paths; a closed path becomes an 
open path; a compound path cannot be split until it has been ungrouped into separate paths.



Square
One of the types for the Ends property of a line style.    Unlike the butt line end style, square line ends 
project half the line's width beyond the end of the line. 



Standard view size
One of 25%, 50%, 100%, 2x, 4x, 8x, 16x, or whole page.



Star
A regular shape with three or more radiating points, drawn using the star tool.



Template
A file type used to store pictures used as a basis for other pictures.



Text controls
A set of text functions which appears when the text tool is selected.    Use the text controls to set the 
font, size, style and justification of text, to adjust the set width and kerning, and to raise or lower the text. 
The text controls can be attached to any edge of the desktop, or they can be displayed in a floating box. 



Text frame
A box marking the boundary of a text object.



Text object
A text item in a picture.    A text object can be manipulated in the picture in the same way as any other 
object.



Text on a path
Text flowing along a path.



TIFF
Tagged Image File Format - a standard file format, often used to store scanned images.



Toolbox
The display of Design Studio tools on the edge of the work area, or in the floating toolbox.



Trace
Construct a path around an image, either manually or automatically.



Tracking
Increasing the space between characters.    Compare with kerning.



Transform
Edit a basic shape by moving, scaling, or reflecting it.



Typeface
The    style of type e.g. Courier, Helvetica, or Times Roman.    Design Studio more commonly uses the
term font to refer to the style of type.



Undo
Undo the last edit or transformation and restore the picture to its former state.



Ungroup
(1) Separate a group into individual objects.
(2) Change a basic shape into a path.



Vector font
A font using lines instead of filled outlines.



Vector-based
Describing a drawing as a series of lines and arcs instead of as a bitmap.



View size
The magnification of a Design Studio picture.



Work area
The area within which a Design Studio picture is created.



Design Studio Picture Window

The Design Studio picture window is your 'drawing board'.    You can draw your pictures anywhere in the 
picture window, but only the objects on the page (i.e. within the blue border) are printed.

You can change the size of the picture window by dragging the sizing border.

You can make the picture window take up the full screen by clicking on the Maximize button.



Non-Client Area

No help topic available for Non-Design Studio area.



Toolbox

The toolbox is the collection of tools that you use to draw and transform objects.    There are eighteen 
tools in total.

The toolbox can be attached to any edge of the desktop, or it can be displayed in a floating box.      To 
move the toolbox:
1. Click on the toolbox, hold down the mouse button and drag the toolbox.    If you hit the edge of the 

desktop, the toolbox will dock there; if you leave it in the middle of the desktop, it will float.

Although only six tools are displayed initially down the left-hand side of the desktop, you can click 
on the black arrow symbol to the right of some of the icons, to display more tools.

The mouse pointer changes to a different shape depending on which tool is selected.

If you click the right button of the mouse while the cursor is over the toolbox, a menu of options 
for configuring the toolbox will appear.

If you want to display all the tools at once, open the toolbox configuration menu and click on 
Show all tools.    Do the same again to return the tools to their six "drawers".

Design Studio remembers the location of the toolbox and displays it in the same place when you 
next load the program. 

Choose the tool for which you require help:

Pointer tool Selecting, dragging, copying
Text tool Entering or editing text objects

Shapes
Box tool Drawing square and rectangular boxes
Round box tool Drawing boxes with rounded corners
Ellipse tool Drawing circles and ellipses
Arc tool Drawing arcs
Pie tool Drawing pie slices
Polygon tool Drawing regular polygons
Star tool Drawing stars

Drawing
Pencil tool Drawing free-form lines
Line tool Drawing straight lines
Curve tool Drawing curve points

Transform
Scale tool Scaling objects
Rotate tool Rotating objects
Skew tool Skewing objects
Reflect tool Reflecting objects

Others



Autotrace tool Tracing imported bitmaps
Magnifier tool Zooming in and out



Information Line

The information line displays information about many aspects of the desktop and the picture you are 
working on.

The information line changes depending upon what you are doing at the time.

To turn the information line off, click on Info Line in the View menu.    Do the same to turn it on 
again.

See also
How to use the information line



Rulers

The rulers help you to size and position the objects you draw.    They appear along the top, and down 
the left-hand side of the picture window.    As you move the mouse pointer, thin hairlines on the rulers 
indicate the pointer's current position.

You can choose not to display the rulers.    Click on Show Rulers in the View menu to turn the 
rulers on and off.

You can change the units of the ruler by clicking on the ruler units box and selecting the units of 
measurement that you want.

The units available are :

inches/tenths

inches/eighths

centimeters

picas and points



Ruler Units

You can change the units of the ruler by clicking on this units box and selecting the units of 
measurement that you want.

The units available are :

inches/tenths

inches/eighths

centimeters

picas and points

All the dialog boxes that you display after this change will default to the unit of measurement that you 
have chosen.



Color Palette

The color palette is displayed at the bottom of the desktop, and it contains a selection of colors. Any new
colors you create will be added to the palette.

To display the color palette, click on Color Palette in the View menu, or click on the Color Palette button
in the shortcuts. Close the color palette by selecting the Color Palette command again.

How to use the color palette

To change the color of an object, select the object and then click the left mouse button on the 
color you require.

To give an object no fill style, select the object and then click the left mouse button on the X 
button in the palette.

To change the color of the line style of an object, select the object and then click the right mouse 
button on the color you require.

To give an object no line style, select the object and then click the right mouse button on the X 
button in the palette.

To change the "to color" of a graduated fill style, select the object, hold down SHIFT and then 
click the left mouse button on the color you require.

To edit a color in the palette, double-click on the color to display the Edit Color dialog box.

To add a new color to the palette, click on the + button to display the New Color dialog box.

You cannot delete a color from the color palette.



Title Bar

The title bar is at the top of the desktop.    This shows the filename of the picture you are working on.

Drag the title bar if you want to move a window around the desktop.

Double-click on the title bar to maximize the window, just as if you had clicked on the maximize 
button.



Minimize Button

Click on this button to reduce the Design Studio desktop to a picture icon.

You can then restore Design Studio by double-clicking on the icon, or by clicking on the icon and 
selecting Restore from the popup menu.

You can also minimize the desktop using the Control Menu.



Maximize Button

Click on this button to increase the picture window to maximum size.    This fills the desktop.

You can also maximize the picture using the Control Menu.



Control Menu

The Control Menu is represented by a box in the top-left corner of the desktop and all dialog boxes. 

You use the Control Menu's commands to position the desktop and dialog boxes on the screen. 

The commands allow you to move and close the desktop and dialog boxes.



Scroll Bar

The scroll bars are at the right, and at the bottom of the picture window, and are used to move different 
areas of the picture into view.

The position of the scroll box in the scroll bar indicates the area of the page that is currently in 
view.

To scroll around the page you can either:

drag the scroll box along the scroll bar.    This moves the picture by the suggested amount in the 
direction you drag it.

or

click on the scroll arrows at either end of the scroll bar.    This moves the picture a small amount in
the specified direction.

or

click on the scroll bar itself beside the scroll box.    This moves the picture one window to the left, 
to the right, up or down.

Use the scroll bar on the right for vertical movement, and the scroll bar at the bottom for horizontal 
movement.



Sizing Border

Drag the sizing border to change the size of the picture window.    The icon changes to a two-way arrow 
when the sizing border is selected.

If you have grabbed the sizing border at one of the corners, you can change the size of the window both
horizontally and vertically.



Shortcuts

The shortcuts are a set of buttons for performing common Design Studio functions.      When you point at
a shortcut button with the cursor, the function of that button is explained in the information line.

The shortcuts can be attached to any edge of the desktop, or they can be displayed in a floating box.    
To move the shortcuts:
1. Click on the shortcuts, hold down the mouse button and drag the shortcuts.    If you hit the edge of 

the desktop, the shortcuts will stay there; if you leave them in the middle of the desktop, they will 
float.

If you click the right button of the mouse while the cursor is over the shortcuts, a menu of options 
for configuring the shortcuts will appear.

Design Studio remembers the position of the shortcuts, and will put them in the same place when 
you next load the program.

If you point at a disabled shortcut (i.e. one which is not available at the current time), the cursor 
goes hollow and a message explaining why the shortcut is disabled appears in the information line. 

The shortcuts available are:

 Display the color palette

 Display the Fill Style dialog box or the Line Style dialog box

      Cut the selected object(s) from the picture, or copy   the selected object(s) to the clipboard,  
or paste the contents of the clipboard into the picture

Undo the last operation, and redo the previous undo

        Repeat the last transformation performed  

Toggle between Preview and Outline format

Display the picture at its actual size, or display the picture so that the whole page is in view

Toggle between displaying and not displaying the grid, and toggle between having Snap Control 
turned on and off

Move the selected object(s) to the front of the picture, or move the selected object(s) to the back   
of the picture

Combine the selected objects into a group, or separate the selected group into its components  

Join the two selected points together (or join text to a path), and break a path at the selected 
point (or split text from a path)

Display the Align dialog box

Display Object Info for the selected object

Turn the pointer into a question mark so that you can ask for help on a specific part of the desktop



Text Controls

The text controls are a set of options which appear whenever the text tool is selected.    They enable you
to edit text.    When you point the cursor at a text control, the function of that control is explained in the 
information line.

If you click the right mouse button while the cursor is over the text controls, a menu of options for 
configuring the text controls will appear.

Design Studio remembers the position of the text controls, and will display them in the same 
place when you next load the program.

If you point at a disabled text control (i.e. one which is not available at the current time), a 
message explaining why the text control is disabled appears in the information line. 

The text controls available are:

          Display a selection of   fonts; click on the one you require

Display the point size; click on the arrows to select the one you require, or type it directly 
into the box

Display the selected text in bold, and display the selected text in italics

Align the text object to the left, center the text object, align the text object to the right, or 
justify the text object

Make the selected characters wider or narrower by 10%

Move the selected text upwards or downwards by one point

Decrease or increase the spacing between selected characters by 1%  





 Pointer tool 

The pointer tool is used to select objects and points on paths, and to manipulate objects by, for example,
moving or stretching them.

To select a single object
1. Select the pointer tool from the toolbox.    The pointer shape changes to an arrow.

2. Position the pointer over the object you want to select and click the mouse button.    The object's 
handles are displayed, indicating that it is selected.    Any previously selected objects are de-
selected.

To select objects using a selection frame
1. With the pointer tool selected, position the pointer at one corner of the group of objects you want to 

select.

2. Drag the pointer across the objects.    A selection frame appears as you drag; all the objects which 
are within (or partially within) the selection frame are selected when you release the mouse button.

To select additional objects
1. Point at the next object you want to select.

2. Hold down SHIFT and click the mouse button.    This adds the object to the selection.

You can SHIFT and click on as many objects as you wish, and you can extend a selection by holding 
down SHIFT while dragging a selection frame.

To drag an object
1. Point at the object you want to move.

2. Hold the mouse button down while you drag the mouse around.    The object is dragged around the 
screen.

To copy an object
1. Point at the object you want to copy.

2. Hold down ALT and drag the object as described above, to make an exact copy.

To stretch an object
1. Point at one of the handles on the object you want to stretch.

2. Click and drag the handle to transform the object.
The effects of this drag depends upon what sort of object you have selected, e.g. a bitmap, 

group, shape, or path.

Selecting points
A point can also be moved, adjusted, or deleted, but first it must be selected.    To select a point on a 
path:
1. Select the path containing the point. 

2. Position the pointer on the point you want to select.    When the pointer is correctly positioned, its 
appearance changes to indicate that it is pointing to a point, rather than to the whole path.

3. Click on the point: it changes from a small black square to either a connector point, a curve point or 
a corner point.    The control points and control lines of the selected points are also displayed.

To select multiple points on a path, hold down SHIFT and click on each of the points to select, or drag 
the pointer tool across the points you want to select. 



Hold down CTRL and drag to pull the control points from points.

The right mouse button
Whichever tool is selected, if you click or drag with the right button on the mouse, you will be able to 
select and drag objects as though you had temporarily switched to the pointer tool.

The middle button of a three-button mouse is never used.
The pointer tool is also used to adjust the angles of an arc or pie slice, by dragging the round 

handles on one of these objects.



 Text tool 

You can enter text directly into your picture.      To do this:
1. Select the text tool from the toolbox.    The pointer shape changes to an I beam when you move it 

into the work area.      Notice also that the menu bar at the top of the screen changes to a text bar.    
This contains text controls which enable you to format the text.

2. Click on the work area approximately where you want the text (you can always move it afterwards), 
and start to type.

When you are using the text tool, you can select text objects by clicking the right mouse button on
them.    If you select a text object in this way, you will not be able to cut, copy or paste, because these 
commands are reserved for use on text selections, not on whole text objects.

See also
How to work with text



 Box tool

Drawing a rectangle
1. If the box tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The list 

of shape tools drops down.

2. Click on the box tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the rectangle is displayed as you drag the mouse. 

4. Release the mouse button when the outline is the size and shape you want. 

The rectangle is drawn with the current default line and filled with the current default fill.    To set the 
default line or the default fill, insure that no objects are selected (by clicking outside all objects), and 
choose the line you want from the Line menu or the fill you want from the Fill menu.

Drawing a square
If you want to draw an exact square, follow the steps above but hold down CTRL as you drag.    

Do not release CTRL until you have released the mouse button.
If you have already begun to drag the mouse across the desktop, you can still press CTRL to 

insure that the shape you draw is an exact square. 

Drawing a rectangle from its center
You can also draw a rectangle about a fixed center point instead of from corner to corner.    To 

draw a shape about its center, follow the steps above but hold down SHIFT as you drag.    Do not release 
SHIFT until you have released the mouse button.    If you have already begun to drag the mouse across 
the desktop, you can still hold down SHIFT to insure that the rectangle is drawn with a fixed center point. 

You can hold down SHIFT and CTRL at the same time to draw an exact square about a fixed center.

See also
How to draw a picture



 Round box tool

Drawing a round box
1. If the round box tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    

The list of shape tools drops down.

2. Click on the round box tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the round box is displayed as you drag the mouse. 

4. Release the mouse button when the outline is the size and shape you require. 

The round box is drawn with the current default line and filled with the current default fill.    To set the 
default line or the default fill, insure that no objects are selected (by clicking outside all objects), and 
choose the line you want from the Line menu or the fill you want from the Fill menu.

Drawing a square round box
If you want to draw an exact square, follow the steps above but hold down CTRL as you drag.    

Do not release CTRL until you have released the mouse button.
If you have already begun to drag the mouse across the desktop, you can still press CTRL to 

insure that the shape you draw is an exact square. 

Drawing a round box from its center
You can also draw a round box about a fixed center point instead of from corner to corner.    To 

draw a shape about its center, follow the steps above but hold down SHIFT as you drag.    Do not release 
SHIFT until you have released the mouse button.    If you have already begun to drag the mouse across 
the desktop, you can still hold down SHIFT to insure that the round box is drawn with a fixed center point. 

You can hold down SHIFT and CTRL at the same time to draw an exact square about a fixed center.

Adjusting the corners for a round box
The curvature of the corners of round boxes is determined by the corner radius. You can edit the corner 
radius to make it larger or smaller.    A larger corner radius will make the shape more rounded; a smaller 
corner radius will make the shape more rectangular.    To adjust the corners of a round box before you 
draw it, double-click on the round box icon to display the Rounded Box dialog box.

You can also change the corner radius of a round box after it has been drawn.    To do this, select the 
pointer tool and double-click on the round box to display the Object popup menu.    Select the Object 
Info option.    The Shape Info dialog box is displayed and you can edit the dimension in the Corner box.

See also
How to draw a picture



 Ellipse tool

Drawing an ellipse
1. If the ellipse tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The 

list of shape tools drops down.

2. Click on the ellipse tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the ellipse is displayed as you drag the mouse. 

4. Release the mouse button when the outline is the size and shape you want. 

The ellipse is drawn with the current default line and filled with the current default fill.    To set the default 
line or the default fill, insure that no objects are selected (by clicking outside all objects), and choose the 
line you want from the Line menu or the fill you want from the Fill menu.

Drawing a circle
If you want to draw an exact circle, follow the steps above but hold down CTRL as you drag.    Do 

not release CTRL until you have released the mouse button.
If you have already begun to drag the mouse across the desktop, you can still press CTRL to 

insure that the shape you draw is an exact circle. 

Drawing an ellipse from its center
You can also draw an ellipse about a fixed center point instead of from corner to corner.    To draw

a shape about its center, follow the steps above but hold down SHIFT as you drag.    Do not release 
SHIFT until you have released the mouse button.    If you have already begun to drag the mouse across 
the desktop, you can still hold down SHIFT to insure that the ellipse is drawn with a fixed center point. 

You can hold down SHIFT and CTRL at the same time to draw an exact circle about a fixed center.

See also
How to draw a picture



 Arc tool

Drawing an arc
1. If the arc tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The list 

of shape tools drops down.

2. Click on the arc tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of a quarter-elliptical arc is displayed as you drag the mouse.    If 
you drag to the right and then down, the arc goes clockwise; if you drag down and then to the right, 
the arc goes counter-clockwise.    The information line indicates the start and end angles of the arc. 

4. Release the mouse button when the arc is the length and shape you require. 
You can give the arc any line style you like.    Make sure that the arc is selected, and then click on 

Popup Lines in the Line menu.
Once you have drawn an arc, you can alter its start and end angles.    To do this, either move the 

start and end points with the pointer tool, or double-click on the arc to call up the Shape Info dialog box.    
You can then type in precise start and end angles.

See also
How to draw a picture



 Pie tool

Drawing a pie slice
1. If the pie tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The list 

of shape tools drops down.

2. Click on the pie tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the pie slice is displayed as you drag the mouse.    There are four 
different pie slices you can draw, each corresponding to a quarter of a circle:

Top left quarter Drag the pointer to the left and then down

Top right quarter Drag the pointer to the right and then down

Bottom right quarter Drag the pointer down and then to the left

Bottom left quarter Drag the pointer down and then to the right

The information line indicates the start and end angles of the pie slice. 

4. Release the mouse button when the pie slice is the size and shape you require. 

The ellipse is drawn with a thin black line and is filled with the current default fill.    To set the default fill, 
insure that no objects are selected (by clicking outside all objects), and choose the fill you want from the 
Fill menu.

Once you have drawn a pie slice, you can alter its start and end angles.    To do this, either move 
the start and end points with the pointer tool, or double-click on the arc and select Object Info to call up 
the Shape Info dialog box.    You can then type in precise start and end angles.

See also
How to draw a picture



 Polygon tool

Drawing a polygon
1. If the polygon tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The

list of shape tools drops down.

2. Click on the polygon tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the polygon is displayed as you drag the mouse. 

4. Release the mouse button when the polygon is the size you require. 

The polygon is drawn with the current default line and is filled with the current default fill.    To set the 
default line or the default fill, insure that no objects are selected (by clicking outside all objects), and 
choose the line you want from the Line menu or the fill you want from the Fill menu.

Changing the number of sides of a polygon
You can change the number of sides a polygon has in two ways.    To change the number of sides of a 
polygon which you have already drawn:
1. Use the pointer tool to select the polygon.

2. Double-click on one of the handles and open up the Shape Info dialog box.

3. Type in the number of sides you require, or use the arrow buttons to choose.    A sample polygon is 
displayed in the preview box.

To change the number    of sides of a polygon before you draw it:
1. Double-click on the polygon tool to display the Polygon dialog box.

2. Type in the number of sides you require, or use the arrow buttons to choose.    A sample polygon is 
displayed in the preview box.

When you change the number of sides of a polygon in the Polygon dialog box, this number is 
used as the default for any subsequent polygons you draw.

If you hold down CTRL while drawing a polygon, the polygon has a 1:1 aspect ratio, i.e. its 
corners all lie on a perfect circle.

Drawing a polygon from its center
You can also draw a polygon about a fixed center point instead of from corner to corner.    To draw

a shape about its center, follow the steps above but hold down SHIFT as you drag.    Do not release 
SHIFT until you have released the mouse button.    If you have already begun to drag the mouse across 
the desktop, you can still hold down SHIFT to insure that the polygon is drawn with a fixed center point.

You can hold down SHIFT and CTRL at the same time to draw a polygon with an aspect ratio of 
1:1, about a fixed center. 

See also
How to draw a picture



 Star tool

Drawing a star
1. If the star tool is not displayed in the toolbox, click on the > symbol next to the shape icon.    The list 

of shape tools drops down.

2. Click on the star tool.

3. Move the pointer onto the work area.    Press the mouse button and drag the pointer diagonally 
across the desktop.    An outline of the polygon is displayed as you drag the mouse. 

4. Release the mouse button when the star is the size you require. 

The star is drawn with the current default line and is filled with the current default fill.    To set the default 
line or the default fill, insure that no objects are selected (by clicking outside all objects), and choose the 
line you want from the Line menu or the fill you want from the Fill menu.

Changing the number of points of a star
You can change the number of points a star has in two ways.    To change the number of points of a star 
you have already drawn:
1. Use the pointer tool to select the star.

2. Double-click on one of the handles and open up the Shape Info dialog.

3. Type in the number of points you require, or use the arrow buttons to choose.    A sample star is 
displayed in the preview box.

To change the number of points of a star before you draw it:
1. Double-click on the star tool to display the Star dialog box.

2. Type in the number of points you require, or use the arrow buttons to choose.    A sample star is 
displayed in the preview box.

When you change the number of points of a star in the Star dialog box, this number is used as 
the default for any subsequent stars you draw.

You can use either the Shape Info dialog box or the Star dialog box to change how pointed the 
star is by altering its inner radius.

If you hold down CTRL while drawing a star, the star has a 1:1 aspect ratio, i.e. its points all lie on
a perfect circle.

Drawing a star from its center
You can also draw a star about a fixed center point instead of from corner to corner.    To draw a 

shape about its center, follow the steps above but hold down SHIFT as you drag.    Do not release SHIFT 
until you have released the mouse button.    If you have already begun to drag the mouse across the 
desktop, you can still hold down SHIFT to insure that the star is drawn with a fixed center point. 

You can hold down SHIFT and CTRL at the same time to draw a star with an aspect ratio of 1:1 
about a fixed center.

See also
How to draw a picture



 Pencil tool

The pencil tool is like the pencil on your desk.    As you drag the pencil around the desktop, a path is 
drawn following the movements of the tool. 

To use the pencil tool:
1. Select the pencil tool from the toolbox.    The pointer shape changes to a pencil when you move it 

into the work area. 

2. Drag the pencil around the work area in the shape of the path you wish to draw.    A thin line is 
drawn, following the movements of the pencil. 

When you release the mouse button, a path is created which consists of a number of line segments 
joined together at points.    Because the path is left selected, these points are indicated by small black 
squares.

If you use the pencil tool when you have another path selected, and the end point of that path is 
also selected, then the path drawn with the pencil tool will join onto the end of the other and the two paths
will become one object.

If no line is drawn through the points, open the Line menu and select Solid.

Erasing a freehand path
You can erase a freehand path while you are still drawing it by holding down ALT and moving the pencil 
pointer back over the path that you have just drawn.    You cannot erase a path in this way if you have 
already finished dragging the mouse and released the mouse button.

Changing the smoothness of freehand paths
You can adjust the smoothness of freehand paths using the Freehand dialog box: display this by double-
clicking on the pencil icon. 

See also
How to draw a picture
How to work with points and paths



 Line tool

Use the line tool to draw straight lines.    To draw a line using the line tool:
1. Select the line tool from the toolbox.    The pointer shape changes to a pencil drawing a straight line 

when you move it into the work area.

2. Position the pointer where you want to start the straight line and click and hold down the mouse 
button.

3. Move the pointer to where you want the straight line to end, and release the mouse button.    A path 
is drawn with a point at each end.    Because the path is left selected, these points are indicated by 
small black squares.    You can move these points around to reposition the line.

If you hold down CTRL while drawing a straight line, the line will be kept horizontal, vertical or on 
the 45 degree diagonal, depending on where you move the pointer.    If you have already begun to drag 
the mouse across the desktop, you can still hold down CTRL to insure that the line is drawn horizontally, 
vertically or diagonally.

If you start or finish dragging the pointer within the join range of the end point of a selected path, 
the new line will be joined to that path.

If no line is drawn through the points, open the Line menu and select Solid.

See also
How to draw a picture
How to work with points and paths



 Curve tool

Use the curve tool to create smoothly curved paths.    To draw a path using the curve tool:
1. Select the curve tool from the toolbox.    When you move the pointer arrow into the work area, it 

changes shape to a cross with a circle at its center.

2. Position the pointer where you want to start the path and click the mouse button.    A small empty 
circle (a curve point) is displayed, indicating that a point has been drawn and is selected.

3. Move the pointer to the next position and press the mouse button.    A line is drawn from the previous
end point to the pointer position, giving a rough indication of where the new line will be drawn.    You 
can drag the new point to place it anywhere on the work area, which will be scrolled if necessary.    
When you release the mouse button, the new point is drawn and left selected; the previous point is 
de-selected and drawn as a black box.    A line is drawn between the two points.

4. Repeat step 3 until the line is complete.
When you have finished drawing the path, you can de-select the last point by pressing the space 

bar.
If no line is drawn through the points, open the Line menu and select Solid.
To draw a closed path, click the tool on the path's start point to link the end point with the start 

point.
To add a corner point to a path, use the curve tool and hold down SHIFT when you click.

Control points determine the curvature of the line between two points.    By adjusting the control points, 
you can change the shape of the curve.    Control points are joined to the line with control lines.

See also
How to draw a picture
How to work with points and paths



 Scale tool

Use the scale tool to "stretch" or "squeeze" objects.

Scaling an object
1. Select the object you want to scale.

2. Select the scale tool by clicking on its icon in the toolbox.

3. Press and hold the mouse button at the point where you want the fixed point to be.    The fixed point 
is the origin of the transformation and is displayed as a small +.    The fixed point can be anywhere 
on the screen, even inside the object.

4. Drag the pointer in any direction.    The original object and an outline of the scaled object will be 
displayed.    As the pointer is dragged up, the vertical scale factor is increased, i.e. the object is 
stretched.    Drag down to reduce the vertical scale factor and squeeze the object.    Dragging to right
or left increases or decreases the horizontal scale factor.

5. Continue dragging the pointer in any direction until the new object is correctly transformed and you 
have created the right size and shape.

6. Release the mouse button.    The new object is redrawn and the original removed from the display.
ALT and drag creates a copy of the transformed object.
CTRL and drag restricts the transformation to horizontal, vertical or angles that preserve the 

aspect ratio.
The whole picture can be scaled by clicking on Select All in the Edit menu, and applying the 

transformation to the selected objects, i.e. the whole picture.
Scaling can be performed by first selecting the object to be scaled, then choosing the scale tool 

and double-clicking anywhere in the picture to display the Scale dialog.
When you are using the scale tool, the information line displays the current scale factors in the 

horizontal and vertical directions.
If not all of the points on the path are selected, then the transformation applies only to the 

selected points.

See also
How to work with objects
How to work with points and paths



 Rotate tool

Rotating an object
1. Select the object you want to rotate.

2. Select the rotate tool by clicking on its icon in the toolbox.

3. Press and hold the mouse button at the point where you want the fixed point to be.    The fixed point 
is the origin of the transformation and is displayed as a small +.    The fixed point can be anywhere 
on the screen, even inside the object.

4. Drag the pointer in any direction.    The original object and an outline of the rotated object will be 
displayed.

5. Continue dragging the pointer in any direction until the new object is correctly positioned. Notice that
moving the pointer in different directions has different effects.

6. Release the mouse button.    The new object is redrawn and the original removed from the display.
ALT and drag creates a copy of the transformed object.
CTRL and drag restricts the transformation to multiples of 45 degrees. 
The whole picture can be rotated by clicking on Select All in the Edit menu, and applying the 

transformation to the selected objects, i.e. the whole picture.
Rotation can be performed by first selecting the object to be rotated, then choosing the rotate tool

and double-clicking anywhere in the picture to display the Rotate dialog.
When you are using the rotate tool, the information line displays the angle of rotation.
If not all of the points on the path are selected, then the transformation applies only to the 

selected points.

See also
How to work with objects
How to work with points and paths



 Skew tool

Use the skew tool to slant and stretch an object in the same transformation.

Skewing an object
1. Select the object you want to skew.

2. Select the skew tool by clicking on its icon in the toolbox.

3. Press and hold the mouse button at the point where you want the fixed point to be.    The fixed point 
is the origin of the transformation and is displayed as a small +.    The fixed point can be anywhere 
on the screen, even inside the object.

4. Drag the pointer in any direction.    The original object and an outline of the skewed object will be 
displayed.

As the pointer is dragged to the right, points above the fixed point are skewed to the right, while 
points below it are dragged to the left.    Dragging to the left reverses the effect. Dragging upwards 
skews points to the right of the fixed point upwards; points to the left are skewed down.    Drag down 
to reverse the effect.

5. Continue dragging the pointer in any direction until the new object is correctly transformed, and you 
have created the right size and shape.

6. Release the mouse button.    The new object is redrawn and the original removed from the display.
ALT    and drag creates a copy of the transformed object.
CTRL and drag restricts the transformation to multiples of 45 degrees. 
The whole picture can be skewed by clicking on Select All in the Edit menu, and applying the 

transformation to the selected objects, i.e. the whole picture.
You can skew an object by first selecting the object to be skewed, then choosing the skew tool 

and double-clicking anywhere in the picture to display the Skew dialog.
When you are using the skew tool, the information line displays the current skew factors.
If not all of the points on the path are selected, then the transformation applies only to the 

selected points.

See also
How to work with objects
How to work with points and paths



 Reflect tool

Use the reflect tool to produce a mirror image of an object with the mirror line passing through the fixed 
point. 

Reflecting an object
1. Select the object you want to reflect.

2. Select the reflect tool by clicking on its icon in the toolbox.

3. Press and hold the mouse button at the point where you want the fixed point to be.    The fixed point 
is the origin of the transformation and is displayed as a small +.    The fixed point can be anywhere 
on the screen, even inside the object.    Experiment with different fixed points to view the effects.

4. Drag the pointer in any direction.    The original object and an outline of the reflected object will be 
displayed.

5. Continue dragging the pointer in any direction until the new object is correctly transformed, and you 
have created the right size and shape.    Notice that moving the pointer in different directions has 
different effects.

6. Release the mouse button.    The new object is redrawn and the original removed from the display.
ALT and drag creates a copy of the transformed object.
CTRL and drag restricts the reflection to multiples of 45 degrees. 
The whole picture can be reflected by clicking on Select All in the Edit menu, and applying the 

transformation to the selected objects, i.e. the whole picture.
Reflection can be performed by first selecting the object to be rotated, then choosing the reflect 

tool and double-clicking anywhere in the picture to display the Reflect dialog box.
When you are using the reflect tool, the information line displays the angle between the mirror line

and the horizontal.
If not all of the points on the path are selected then the transformation applies only to the selected

points.

See also
How to work with objects
How to work with points and paths



 Autotrace tool 
The autotrace tool automatically traces a path around the outline of an imported image.    To autotrace 
an image:
1. Import the image, by using Import from the File menu.

2. Click on, or near, the edge of the bitmap image with the autotrace tool (grouped with the magnifier in
the toolbox).    A path is drawn around the image outline.    If a fill style is selected, the path will be 
filled.    Autotrace will trace only one area of a bitmap; if the bitmap consists, for example, of two 
distinct objects such as a tennis racket and a ball, which of these is traced will depend on which is 
nearest to the point at which you click.

You can also autotrace a hole in an image by clicking anywhere within the hole.    This draws a 
complete closed path.

The autotrace tool can also be used to trace part of an outline.    This is an effective way of 
cropping an image; for example, if you import an image of a body and you want to crop off the head, click 
the tool to the right of the neck and drag the tool to the left.    The path is drawn around the body from 
where the dragged line cuts the neck, to where the line leaves the neck on the other side.

Notice that the path is an open path, so it is not filled. Dragging the autotrace tool always creates 
an open path, even if the path is in fact drawn all the way round the object.

If the tool was dragged from the left to the right of the neck, the path would be drawn around the 
head.    This is because the path is drawn from the entry point to the exit point of the line that cuts through 
the image, keeping the black (darker) pixels on the right.    If you apply this to a "hole" in an image, the 
path will be drawn in the opposite direction to the example above.

The accuracy of the autotrace tool can be adjusted.    Double-click on the autotrace tool icon in the 
toolbox to display the Autotrace dialog box.

See also
How to work with graphics



 Magnifier tool 

Use this to magnify selected areas of your picture.    The current magnification factor is shown in the 
information line.

To magnify part of a picture
Select the magnifier tool from the toolbox and click on the point of your picture that you wish to appear 
at the center of the window.    Your picture will be magnified to the next 'standard' view size.    Each 
subsequent click will increase the view size to the next standard size.    The information line indicates the
current view size as a percentage. 

To magnify a specific area of the picture
Select the magnifier tool and drag the mouse pointer over the area which you wish to enlarge.    A 
rectangular frame indicates the area that will be enlarged.    Release the mouse button when you have 
selected the area you want.    The selected area will enlarge to fill the window.

To zoom back out
To view a larger area of the picture, hold down SHIFT and click the magnifier tool on the area that you 
wish to zoom out from.    Each click will display the picture at    the next standard size.

See also
How to view the picture





Create pictures

How To ...

Open a new or existing picture
Close/save a picture
Change the page format (page size, etc.)
Use templates
Quit Design Studio



Draw a picture

How To ...

Draw a shape
Draw a precise circle/square
Draw a shape from the center
Change the corner radius of a round box
Change the inner radius of a star
Use the drawing tools to draw a path
Control the angles in a path
Join the two ends of a path (closing the path)
Convert shapes into paths
Blend between objects



View a picture

How To ...

Zoom in and out of the picture
Use preview
Use the information line
Use the shortcuts
Use rulers and grids
Change units



Work with objects

How To ...

Select/de-select objects
Select/de-select all the objects in a picture
Move objects
Specify an object's position
Group/ungroup objects
Align objects
Transform objects using the transform tools



Work with points and paths

How To ...

Select/de-select points
Select/de-select all points on a path
Insert/delete a point
Add a point to a path
Move a point
Use control points

Split a path
Join paths



Work with text

How To ...

Enter text
Edit text
Use the text controls
Change letter, word, or line spacing
Import text from other applications
Join text to a path
Change text on a path
Manipulate text



Use lines, fills and colors
How To ...

Display and use the color palette
Give an object a line or fill style
Color an object
Create a new color



Cut, copy, paste and delete objects

How To ...

Use cut, copy and paste
Delete an object



Work with graphics

How To ...

Import an image
Autotrace an image
Color an image
Import a line-art graphic (metafile)
Export images and line-art



Print pictures

How To ...

Print a picture
Change your printer



Open a new or existing picture

How to open a new picture
1. Click on New in the File menu.    A new picture is opened, and given the title "Untitledn", where n is 

a number.
The new picture has the default page format.    You can change the page format in the Page 

Format dialog box.

How to open an existing picture
1. Click on Open in the File menu.    The Open dialog box is displayed.

2. Select the type of file you want to open (Picture or Template) in the List Files of Type list box.

3. Select the directory where the file is located in the Directories list box.    The files of the appropriate 
type are displayed in the File Name list box.

4. Select the file you want to open by clicking on the file name, and click on OK.    A picture is opened 
and given the name of the file as a title.

If there is another picture open when you choose to open a file, the first picture will be closed.    
You will be asked if you want to save changes to this picture before it is closed.



Close/save a picture

Saving a picture makes a permanent record of the picture on your hard disk.    No changes to your 
picture are made on your disk until the picture is saved.    It is sensible to save your pictures regularly.

How to save a picture
Click on Save in the File menu.    The picture in the current window is saved, but it remains open.    If the
picture in the window is untitled, you are prompted to give the file a name via the Save As dialog box.

How to save a picture to a new file
1. Click on Save As in the File menu.    The Save As dialog box is displayed.

2. Select the type of file you want to save as (Picture or Template) in the Save File as Type list box.    
Most of your pictures will be saved as .ART files.

3. Select the directory where the you want to save the file in the Directories list box.    The files of the 
appropriate type are displayed in the File Name list box.

4. Type in the name of the file you want to save as, or select the file you want to overwrite by clicking 
on the file name, and click on OK. 

The title bar of the window changes to display the new file name.
The old picture is saved, without saving any of the changes made since the previous save.
You are prompted to take action if the file is going to overwrite an existing file.

Save shortcut
Press F2 to save the current picture.

How to close a picture
To close a picture, you can either:

Open another picture.    This causes Design Studio to close the picture which is already open.

or
Quit Design Studio.



Change the page format (page size, etc.)

A page has many attributes which you can modify.

How to change the page format
1. Click on Page Format in the File menu.    The Page Format dialog box is displayed.

2. Click on the page size you require in the Page Sizes list box.

3. Select the picture orientation you require (Portrait or Landscape).
You can create a page size of your own: instructions for doing this are given below.
You can change the page format of a picture while you are working on it.

How to create a custom page format
1. Click on Page Format in the File menu.    The Page Format dialog box is displayed.

2. Enter a name for the new page size in the Page Sizes title bar.

3. Type the dimensions you want to use in the Height and Width boxes.

4. Click on the Add button to add the new page format to the list.
Create a custom page size if you do not want to use any of the pre-defined page sizes.
The maximum page size is 60cm square (approximately 24 inches square).

How to delete a custom page format
1. Select the custom page size you wish to delete in the Page Sizes title bar.

2. Click on the Delete button to delete the page format from the list.
You cannot delete the Design Studio predefined page formats in this way; only custom page 

formats can be deleted.



Use templates

A template is effectively a picture with no contents.    This template holds the page size, page format and
colors that you can use to build a picture.

Use a template to save time and effort if you regularly create pictures which are similar, e.g. if most of 
your pictures use similar colors, or if you use the same image as a logo.

How to save a picture as a template
1. Click on Save As in the File menu, to display the Save As dialog box.

2. Select Template from the Save File as Type list box.

3. Type in the name for the template file.    The file will automatically be given the .TEM file extension, 
unless you specify another one.

4. Click on OK.    You then have the option to make this template your default template.

5. Select Yes if you want it to be the default template, or No if you do not.
The default template is loaded automatically whenever you start up the program.

How to load a template
1. Click on Open in the File menu, to display the Open dialog box.

2. Select Template from the List Files of Type list box.

3. Select the name of the template you want to open, and click on OK.    You then have the option to 
make this template your default template.

4. Select Yes if you want it to be the default template, or No if you do not.
When you open a template, it is shown in the window, but the filename remains "Untitled".



Quit Design Studio

How to quit Design Studio
1. Select Exit from the File menu.

If you have a picture open, you will be asked if you want to save it.
You can also quit Design Studio via the Control Menu, or by using the Control Menu shortcut, 

ALT+F4.



Draw a shape

You use the same technique to draw boxes, rounded boxes, ellipses, arcs, pie slices, polygons and 
stars.

How to draw a basic shape
1. Select the shape tool you want from the toolbox.

2. Click and hold the mouse button somewhere on your picture and drag the shape pointer diagonally 
across the desktop.    An outline of the shape is drawn as you drag the mouse.

3. Release the mouse button when the outline is the size and shape you require.    Eight handles 
appear around the edge of the shape, indicating that the shape is selected.

If the shape tool you need is not displayed, click on the black arrow next to the shape icon to give 
a list of shape tools.    Select the one you want.

The shape is drawn with the current line style and fill style.
A basic shape can be ungrouped, which converts it into a path.
To change the number of points on a polygon, double-click on the polygon tool to display the 

Polygon dialog box.
To change the number of points on a star, double-click on the star tool to display the Star dialog 

box.

See also
Box tool
Round box tool
Ellipse tool
Arc tool
Pie tool
Polygon tool
Star tool



Draw a precise circle/square

You can draw an exact square or circle.

How to draw a precise circle/square shape
1. Select the tool you need, as in How to draw a shape

2. As you drag the pointer, hold down CTRL.    This allows you to draw an exact square or circle.    
Release the mouse button when you have the correctly sized shape.    Do not release CTRL until 
you have released the mouse button.

You can press CTRL part way through a drag, to insure that the shape is an exact square or 
circle.

You can hold SHIFT and CTRL at the same time to draw an exact square or circle from its center.

See also
Box tool
Round box tool
Ellipse tool
Arc tool
Pie tool
Polygon tool
Star tool



Draw a shape from the center

You can draw a shape from a fixed center point instead of from corner to corner.

How to draw a shape from the center
1. Select the tool you need, as in How to draw a shape

2. As you drag the pointer, hold down SHIFT.    The shape is drawn with its center at the point where 
you began to drag.    Release the mouse button when you have the correctly sized shape.    Do not 
release SHIFT until you have released the mouse button.

You can press SHIFT part way through a drag, to insure the shape is drawn from the center.
You can hold SHIFT and CTRL at the same time to draw an exact square or circle from its center.

See also
Box tool
Round box tool
Ellipse tool
Arc tool
Pie tool
Polygon tool
Star tool



Change the corner radius of a round box

You can change the radius of the corners of a round box, to make the box more rounded, or more 
rectangular.

How to change the corner radius of a round box
There are two ways to do this.    To change the corner radius of future round boxes:
1. Double-click on the round box icon in the toolbox.    This displays the Rounded Box dialog box.

2. Type the size of the corner radius you want, and click on OK.

To change the corner radius of an existing round box:
1. Select the pointer tool and double-click on the round box whose corner radius you wish to change.    

This displays the popup menu.

2. Select Object Info from the popup menu to display the Shape Info dialog box.

3. Type the size of the corner radius you want in the Corner box, and click on OK.
You can also display the Shape Info dialog box by selecting the round box and then clicking on 

the Object Info button in the shortcuts.
The size you set remains the default corner radius until you alter it again.    Subsequent round 

boxes will be drawn with this corner radius.

See also
Round box tool
How to use the shortcuts
Shortcuts



Change the inner radius of a star

You can change the inner radius of a star, to make the star more blunt or more pointed.

How to change the inner radius of a star
There are two ways to do this.    To change the inner radius of future stars:
1. Double-click on the star icon in the toolbox.    This displays the Star dialog box.

2. Type the inner radius you want, or drag the slider to change the inner radius, and click on OK.

To change the inner radius of an existing star:
1. Select the pointer tool and double-click on the star whose inner radius you wish to change.    This 

displays the popup menu.

2. Select Object Info from the popup menu to display the Shape Info dialog box.

3. Type the inner radius you want in the Inner Radius box, and click on OK.
You can also display the Shape Info dialog box by selecting the star and then clicking on the 

Object Info button in the shortcuts.
The inner radius you set remains the default inner radius until you alter it again.    Subsequent 

stars will be drawn with this inner radius.

See also
Star tool
How to use the shortcuts
Shortcuts



Use the drawing tools to draw a path

You use the drawing tools to create paths.    The different tools allow you to draw freehand paths, 
straight paths and curved paths.    You must select a drawing tool before you can draw a path.

How to select a drawing tool
1. If the drawing tool is not displayed, click on the black arrow next to the drawing tool icon.    The list of

drawing tools drops down.

2. Click on the tool you require.
When you move the pointer into the work area, the pointer arrow changes to a different shape, 

depending upon the tool you have selected.

How to use the drawing tools to draw a path
Choose the tool you need more information on:

Pencil tool         Drawing freehand lines  
Line tool Drawing straight lines
Curve tool Drawing curved paths



Control the angles in a path

You can control freehand and curved paths so that the next point in the path is at a multiple of 45 
degrees, e.g. 0, 45, 90, 135, 180 etc.

How to control the angle of a path
Hold down CTRL as you drag the mouse to draw the path. When you release CTRL you can continue 
drawing your path without the angle constraints.



Join the two ends of a path (closing the path)

You can close an open path to create a closed path, which can then be filled with a fill style or color.    
There are two ways of closing a path.

How to close a path
1. Draw the path in the normal way using the drawing tools.

2. With the drawing tool you have selected, click on, or very close to, the first point on the path, so that 
a path is drawn from the last point to the first point.    The path will be closed if the points are close 
enough together.

The path is automatically filled with the selected fill style.
If the two points are not close enough to be joined, then move the last point nearer to the first 

point, select both points, and click on Join in the Object menu (or click on the Join button in the 
shortcuts).

Alternatively, you can join the two ends of a path in this way:
1. Display the Path Info dialog box, by clicking on Info in the Object menu (or by double-clicking on 

the path to display the popup menu and then selecting Object Info).

2. Click on the Path Closed check box to select it and click on OK.

See also
How to join paths
How to use the shortcuts
Shortcuts



Convert shapes into paths

Basic shapes, such as boxes and ellipses, are formed from closed paths.    These can be converted into 
paths.    You can then select and edit individual points on the path to modify the shape.    There are two 
ways of converting a shape into a path.

How to convert a shape into a path
1. Select the shape you want to convert into a path.

2. Click on Ungroup in the Object menu, or click on the Ungroup button in the shortcuts. The shape is
converted into a path of the same shape.    The shape handles are replaced by points on the path.

An ungrouped shape does not lose its fill style or color.

You can also convert a shape into a path in this way:
1. Double-click on the selected shape to display the popup menu.

2. Select Convert to path from the popup menu.

See also
How to work with points and paths



Blend between objects

You can create the effect of one object transforming into another by using the blend function. 

Blend draws a number of paths interpolated between two selected paths or shapes.    You can only 
blend between two paths or shapes.    You cannot use blend on images, groups of objects, or text 
(unless it has been ungrouped into individual closed paths).

How to blend one object with another
1. Select two paths, or shapes.

2. Click on Blend in the Edit menu.    The Blend dialog box is displayed.

3. Select the number of blend stages you need, and click on OK.    The two paths are blended together.

If the two objects are colored, each blend stage is given an intermediate color.    For example, if one 
object is black and the other is white, the objects at each of the blend stages are given different shades 
of gray, darker at the black end and lighter at the white end.

The line and fill styles of the two objects are also approximated in the intermediate paths.
The paths you use to blend can be open and/or closed.
You will normally use the default  First Stage and  Last Stage values. The defaults are 

calculated so that the blend will be even and gradual, given the number of blend stages.
The intermediate stages are always drawn as paths.
Try a smaller rather than larger number of blend stages first, because a blend with many stages 

may take a long time to draw.

How to change the blend effect
You can change the effect of a blend by changing the reference points of a transformation.
1. Select the two paths to blend.

2. Select a point on one or both of the paths.

3. Select Blend from the Edit menu and continue as above.
If you do not specify a reference point, the first points on the paths are used.
You can achieve many effects using different reference points.    Try them out or look in the 

manual for examples.



Zoom in and out of the picture

You can zoom in and out of the picture in several ways.

How to zoom in (enlarge) the picture
1. Select the magnifier tool from the toolbox.

2. Click on the point of your picture that you want to appear at the center of your picture. The picture is 
then magnified to the next standard view size. Click again to zoom in another stage.

You can also drag the magnifier tool across the area of the screen you want to magnify.
The maximum magnification is 1600%.
The magnifier tool is grouped with the autotrace tool in the toolbox.
The information line displays the current view size as a percentage.

How to zoom out (reduce) the picture
1. Select the magnifier tool from the toolbox.

2. Press SHIFT and click on the point of your picture that you want to appear at the center of your 
picture.    The picture is then reduced to the next standard view size.    Click again to zoom out 
another stage.

The minimum magnification is about 25%.

You can also zoom in and out (enlarge/reduce) in these ways:
Click on Enlarge or Reduce in the View menu, or use the shortcuts for these which are F8 for enlarging
and SHIFT+F8 for reducing.

or
Click on the magnifier in the information line.    This displays a popup menu from which you select the 
magnification you want.    The current center of the picture remains centered.

See also
How to use the information line
How to use the shortcuts
Shortcuts



Use preview

You can display your picture in either outline or preview format.
A picture in outline format displays all the objects in the picture with the same thin line style, 

without colors, fills, or other line styles.
A picture in preview format displays all colors, fill styles and line styles.
Preview format takes longer to redraw the screen.    Turn preview format off when the picture is 

complicated and it takes too long to redraw the screen.    Turn preview format back on when it is essential 
to see the colors, line styles, etc.

How to change between preview and outline format
To change between preview and outline format do any of the following:

Click on Preview in the View menu
Press F6 to toggle between the two formats.
Click on the Preview button in the shortcuts.

See also
How to use the shortcuts
Shortcuts



Use the information line

The information line displays information about many aspects of the desktop and the picture you are 
working on.

The information line changes depending upon what you are doing at the time and where on the 
desktop the cursor is positioned.

The information line can be turned off by clicking on the Info Line command in the View menu.    
This is a toggle command: if you click on it when the information line is displayed, it turns it off: if you click 
on it when the information line is not shown, it turns it on.

The information displayed
Normally, when the cursor is not over any of the tool or button bars the information displayed is:

Current pointer position.
Currently selected object. Click on the object information to display the Object Info dialog for the 

selected object.
Current view size. Click on the magnifier or current view size to display a popup menu of the view

sizes available.
Current tool and hints on how to use it.

When the cursor is over the toolbox, the information line displays a description of the tool you are 
pointing at.

When the cursor is over the shortcuts, the information line displays a description of the button you are 
pointing at.

When the cursor is over the color palette, the information line displays hints for using the color palette, 
and descriptions of the buttons at either end of the palette.

When the cursor is over the text controls, the information line displays a description of the text control 
you are pointing at.

When selecting a command from a menu, the information line displays a short description of the function
of the command.

When a dialog box is displayed, the information line displays the name of the dialog box.

During a transformation using the transform tools, the information line displays the skew or scale factors,
or the angle of rotation or reflection, or the displacement of an object being moved.

While importing or exporting a graphic, the information line displays the percentage of the import 
completed, or the path and filename of the exported file.



Use the shortcuts

Several actions have been assigned to shortcut buttons.    These shortcuts are one-click buttons which 
enable you to perform common actions quickly.    To use a shortcut, simply click on it.

How to move the shortcuts

The shortcuts can be moved around the desktop at your convenience.    To move the shortcuts:
1. Click the left mouse button anywhere on the shortcuts and hold it down.

2. Drag the mouse across the desktop, and a rectangle representing the shortcuts will follow.    If you 
bump into the edge of the desktop and release the mouse button, the shortcuts will stay at that 
edge.    If you release the mouse button in the middle of the window, the shortcuts will float.

or
1. Click the right mouse button anywhere on the shortcuts.

2. A popup menu is displayed: select where you would like to position the shortcuts.
Once you have positioned the shortcuts, Design Studio remembers this setting and will put the 

shortcuts in the same place whenever you load the program, until you move them again.
When you select the text tool, the shortcut bar is replaced by the text control bar.    You can 

choose to have them both displayed at once by clicking the right mouse button over the shortcuts, and 
selecting Swap when editing text from the popup menu. 

See also
Shortcuts



Use rulers and grids

You can use the rulers and grids to help size and position objects correctly on the page.    The rulers and
the grid are optional.

How to use rulers
The units used by the rulers are indicated in the ruler units box.    The ruler units box is the box 

which intersects the two rulers in the top left-hand corner. 
To change the units, click on the ruler units box, and select the units you want from the popup 

menu.    The units you choose will then become the default units for all the dialog boxes you use 
afterwards.

To adjust the ruler origin, click on the ruler units box and select Adjust Ruler origin, then click at 
the point where you want the origin to be.

Reset the original ruler origin by clicking on the ruler units box and selecting the Reset Ruler 
origin command.

Ruler units are assigned to a window.    Changing the units in one window will not affect the units 
in another window.

Click on Show Rulers in the View menu to turn rulers on and off.

How to use grids
Click on Grid in the View menu to display the Grid dialog box.
Snap control aligns objects to the nearest grid setting when they are drawn or moved.
Using the grid slows down the redrawing of a picture.
Grid spacing can be set independently of the rulers, e.g. rulers could be in inches/eighths and the

grid spacing could be in centimeters.
Click on the appropriate check boxes in the Grid dialog box to turn Grid, and Snap control, on 

and off.    Alternatively, you can click on the Grid and Snap buttons in the shortcuts.

See also
How to use the information line
How to use the shortcuts
Shortcuts



Change units

You can change the units of the rulers.    This also changes the units that all the dialog boxes default to.

How to change the units
1. Click on the ruler units box to display a popup menu.    The ruler units box is the box which intersects

the two rulers in the top left-hand corner.

2. Click on the units you want to use from the popup menu.    The units available are :
inches/tenths
inches/eighths
centimeters
picas and points
If the ruler units box is not displayed, then click on Show Rulers in the View menu.
You can change the units as often as you like.

See also
How to use rulers and grids



Select/de-select objects

You must select an object before you can do anything with that object. There are many ways to select a 
single object.

How to select an object
1. Select the pointer tool.    The pointer shape changes to an arrow.

2. Position the pointer over the object you want to select and click.    The object's handles are 
displayed.

Any previously selected objects are de-selected as soon as you select another object.
When you select an object, that object's line and fill styles become the default for any new objects

you create.

How to select additional objects
1. After selecting an object, point at the next object you want to select.

2. Hold SHIFT and click.    This adds the object to the selection.
You can SHIFT and click on as many objects as you wish.

You can also select objects using the selection frame:
With the pointer tool selected, drag the pointer from one corner of the object to another.    A selection 
frame appears as you drag.    All the objects which are within (or partially within) the selection frame are 
selected when you release the mouse button.

If an object was already selected before you dragged the selection frame over it, it will remain 
selected.

You can extend a selection by holding SHIFT while dragging a selection frame.

You can also select objects by using TAB:
Use TAB to cycle forwards (or SHIFT+TAB    to cycle backwards) through the objects in the picture, 
selecting each one, and de-selecting the previous one.

How to de-select an object
You can de-select an object in any of the following ways:

Click the pointer tool away from any objects to de-select all objects.
Hold down SHIFT and click on an object to de-select that object.
Press ESC to de-select all objects.

See also
Pointer tool



Select/de-select all the objects in a picture

How to select all the objects in a picture
Click on Select All in the Edit menu, or use the shortcut ALT+A. All the objects in the picture will be 
selected.

You could also select all the objects by dragging a selection frame over the objects.

How to de-select all the objects in a picture
You can de-select all objects in either of the following ways:

Click the pointer tool away from any objects.
Press ESC.

See also
Pointer tool



Move objects

You can move objects by dragging them around the picture.    For more precise work, you can specify in 
which direction and by how much you want to move the object.

How to move an object
1. Select the object.

2. Drag the object to its new position.    As you drag the object, the original object and an outline of its 
new position are displayed.    Release the mouse button to redraw the object in the new position.

If you drag the object beyond the window limits, the window scrolls to display the moved object.
The information line displays the displacement of the object, as you drag it.
Hold down CTRL and drag the object to constrain movement of the object to angles which are 

multiples of 45 degrees, e.g. 0, 45, 90, 135, 180, etc.
Hold down ALT and drag the object to make a copy of it when you release the mouse button.

How to move an object by a specific amount
1. Select the pointer tool and double-click on the object you want to move, to display the popup menu.

2. Select Move/Copy from the popup menu to display the Move Object dialog box.

3. Use the dialog box to specify in which direction and by how much you want to move the object, then 
click on OK.

You can select and move multiple objects using this method.    Simply double-click on one of the 
selected objects to display the popup menu, and continue as above.

If you want to copy the object, select the Copy Object check box before you click on OK.



Specify an object's position

You can specify exactly where an object should appear in a picture.

How to specify an object's position
1. Select the object you want to move.

2. Click on Info in the Object menu (or click on the Object Info button in the shortcuts), to display the 
Shape Info dialog box.

3. Specify the desired position of the object in the Position group box, and click on OK.
The coordinates are specified from the top left corner of the page, i.e. top left is given the 

coordinate 0,0.
You can specify the position of the left, center or right of the object, horizontally, and the top, 

middle or bottom, vertically.
The Shape Info dialog box can also be displayed by double-clicking on the object and selecting 

Object Info from the popup menu.
You can not move multiple objects in this way.

See also
Shape Info dialog box
Group of Objects dialog box
Object Info (Image) dialog box
Path Info dialog box
Text on a Path dialog box
Text Info dialog box
Spacing dialog box
Multiple Objects dialog box
How to use the shortcuts
Shortcuts



Group/ungroup objects

You can group together selected objects into a single object called a group.    The grouped objects then 
act as one object, for the purposes of movement, coloring, etc.

How to group objects
1. Select all the objects you wish to group.

2. Click on Group in the Object menu, or click on the Group button in the shortcuts.    The selected 
objects are grouped together and displayed in a single frame with clear handles.

All of the operations you can carry out on an object can be carried out on a group.
The information line tells you if an object is a group when it is selected.

How to ungroup objects
1. Select the group you want to ungroup.

2. Click on Ungroup in the Object menu, or click on the Ungroup button in the shortcuts. The group is 
ungrouped into its component objects, which are left selected.

You can ungroup basic shapes and text to produce paths of the same shape.
You can also ungroup a group by selecting the group and double-clicking to display the popup 

menu.    Select the Ungroup option from the popup menu.
Certain letters when ungrouped produce compound paths, e.g. B or D. Ungroup these again to 

produce separate closed paths.

See also
How to use the shortcuts
Shortcuts



Align objects

You can align objects with the page, and with each other to the left, center or right, or to the top, middle 
or bottom.    This removes guesswork and reduces effort.

How to align to the left
1. Select the objects you want to align.

2. Click on Align in the Object menu (or click on the Align button in the shortcuts), to display the Align 
dialog box.

3. Select the Left option button.    The preview box illustrates the effect of the alignment.

4. Click on OK.
The objects are aligned to the left-most point of all the selected objects.

You follow the same process to align a number of objects to the center or right, and/or the top, middle, or
bottom, by selecting the appropriate buttons.    The preview box on the Align dialog box illustrates the 
effect of each type of alignment

You can align horizontally and vertically at the same time, e.g. to align two circles of different 
sizes, one inside the other, align to the center and to the middle.

How to align to the page
Repeat the steps as above, but with the Page option button selected instead of the Each other option 
button.

If only one object is selected, you can only align to page.

See also
How to use the shortcuts
Shortcuts



Transform objects using the transform tools
You use the transform tools to apply transformations to shapes, paths, points, text and group objects.

How to select a transform tool
1. If the transform tool you require is not displayed, click on the black arrow next to the transform tool 

icon.    The list of transform tools drops down.

2. Click on the tool you require.

How to transform objects using the transform tools
You use each of the transform tools in the same way.    To transform an object:
1. Select the object you want to transform.

2. Select the transform tool as above.

3. Press and hold the mouse button at the point where you want the fixed point of the transformation to
be.    For instance, if you are doing a reflection, you need to position the transform tool on the mirror 
line.

4. Drag the pointer in any direction.    The effect of this depends upon the tool you have selected.

5. Continue dragging the pointer in any direction until the new object is correctly transformed, i.e. the 
right shape and size.

6. Release the mouse button.
The fixed point is the origin of the transformation, displayed as a small +.    The fixed point can be 

anywhere on the screen, even inside the object.
The information line will display the angle of rotation or reflection, or the scale or skew factors, as 

the transformation is taking place.
Transformed text can still be edited.

All of the transform tools display a dialog box if you select the tool, select the object you want to
transform and double-click the tool in the picture.    These dialog boxes allow you to specify a 
transformation more accurately than you can by simply using the mouse.
Choose the tool you need more information on:

Scale tool Scaling objects
Rotate tool Rotating objects
Skew tool Skewing objects
Reflect tool Reflecting objects

How to repeat a transformation
You can perform a transformation over and over again, for example to repeat petals round the center of 
a flower.    

To repeat a transformation click on Transform Again in the Edit menu, or click on the Transform Again 
button in the shortcuts.

See also
How to use the shortcuts
Shortcuts



Select/de-select points

Before you can move, adjust or delete points, they need to be selected.

How to select a point
1. Select the path containing the point.

2. Position the pointer on the point you want to select, and click.
The point changes from a small black square to either a curve point or a corner point.    The 

control points and control lines of the selected points are displayed.
When pointing to a point, the pointer changes to indicate this.

How to select additional points
1. After selecting a point, point at the next point you want to select.

2. Hold SHIFT and click.    This adds the point to the selection.
You can SHIFT and click on as many points as you wish.

You can also select points using the selection frame:
With the pointer tool selected, drag the pointer so that all the points you want to select appear within the 
selection frame.    These points become selected when you release the mouse button.

If a point was already selected before you dragged the selection frame over it, it will remain 
selected.

You can extend a selection by holding SHIFT while dragging a selection frame.

How to de-select a point
You can de-select a point in any of the following ways:

Click the pointer tool away from the path to de-select the path and any points on the path.
Click on SPACE to de-select all points on a path and leave the path still selected.
Hold down SHIFT and click on a selected point to de-select the point without de-selecting the 

path.

See also
Pointer tool



Select/de-select all points on a path

You can select all the points on a path so that you can transform all of the points at once.

How to select all points on a path
1. Drag the pointer tool across the path so that all the points on the path appear within the selection 

frame.

2. De-select any objects that also become selected as a result.

How to de-select all points on a path
You can de-select all points on a path in the following ways:

Click the pointer tool away from the path to de-select the path and any points on the path.
Press SPACE to de-select all points on a path and leave the path still selected.

See also
Pointer tool



Insert/delete a point

You can insert points into paths and delete points from paths.    This lets you control the shape of the 
path more freely.

How to insert a point into a path
1. Select the path.

2. Select the curve tool.

3. Click on the path at the position where you want the new point to be.    If you want the new point to 
be a corner point, hold down SHIFT when you click.

The new point becomes selected, and any other previously selected points become de-selected.
If you do not click exactly on or very close to the path, it will become de-selected and a point will 

be drawn on its own.    The information line will indicate this.

How to delete a point from a path
1. Select the point on the path you want to delete.

2. Double-click on the selected point, to display the popup menu.

3. Click on Delete Points in the popup menu.    The path is redrawn without the point.
Pressing BACKSPACE when a path is selected will delete all selected points on the path.
You can delete multiple selected points with one command.
Deleting a point on a closed path does not convert it into an open path.

See also
Pointer tool



Add a point to a path

You can extend a path by adding a point to its end.

How to add a point to a path
1. Select the point at one end of the open path.

2. Select the curve tool for the point.

3. Click where you want the additional point to be.    The path between the existing end point and the 
new point is drawn.    If you want the new point to be a corner point, hold down SHIFT when you 
click.

The new end point is selected and the old end point is de-selected.
To close an open path, repeat as above but click the tool on the other end of the open path.

See also
Pointer tool



Move a point

You can move a point to change the shape of a path.

How to move a point
1. Select the point and drag it to its new position.

2. Release the mouse button when the point is in the right place.    The path is redrawn through the 
new point.

While you drag, both the new path shape and the original are displayed.
If you select more than one point to drag, the selected points remain in the same position relative 

to each other.    The other points are redrawn as required.
You cannot make a copy of an individual point on a path.    Hold down ALT and drag to make a 

copy of the whole path.

See also
Pointer tool



Use control points

Control points are the points on the end of the control lines which control the direction of a path through 
a point.    You can adjust these control points to change the shape of the path.

How to adjust the control points
1. Select the point you want to adjust.    The control lines and points should be displayed.

2. Point at one of the control points.

3. Drag the control point to its new position.    While you drag, both the new path shape and the original
are displayed.

4. Release the mouse button when you have the shape you need.
If no control points are displayed when you select the point, then either they do not exist, or they 

are hidden by the point to which they belong.    Make the control points appear by holding CTRL before, 
and while, you drag the pointer away from the point.

How to change the style of a point
1. Select the point you want to change.

2. Select Info from the Object dialog box, or click on the Object Info button in the shortcuts, to display 
the Path Info dialog box.

3. Click on the point style you require, i.e. Corner or Curve, in the Points Selected group box.

4. Click on Auto Curvature, if you want the path to be drawn smoothly through the point.

5. Click on OK.    The style of the point is changed, and the path is redrawn if the style change affects 
it.

You can select multiple points and change them all together in this way.
You can also display the Path Info dialog box by double-clicking on the point and selecting 

Object Info from the popup menu.

See also
Pointer tool
Shape Info dialog box
Group of Objects dialog box
Object Info (Image) dialog box
Path Info dialog box
Text on a Path dialog box
Text Info dialog box
Spacing dialog box
Multiple Objects dialog box
How to use the shortcuts
Shortcuts



Split a path

You can split a path into two or more sub-paths and manipulate each sub-path as a separate object.

How to split a path
1. Select the path you want to split.

2. Select the points at which you want to split the path.

3. Click on Split in the Object menu, or click on the Split button in the shortcuts.    The sub-paths are 
redrawn and the end points of the new paths become selected.

The paths appear as a single path, so you need to separate them to avoid confusion.    Isolate the
paths by de-selecting one and dragging the selected one away.

You can split a path into as many sub-paths as you want.
If there is no point at the place you want to split the path, then insert a point.
You can also split the path by double-clicking on the point and selecting Split path in the popup 

menu.
You can turn a closed path into an open path by splitting the path at only one point.    This change 

is indicated in the information line.
If there is text on the path you choose to split, you will need to use the Split command twice. The 

first Split will separate the text from the path, the second Split will split the path into sub-paths.

See also
Pointer tool
How to use the shortcuts
Shortcuts



Join paths

You can join one path to the end of another.

How to join paths
1. Select and drag one path so that the end point coincides with the end point of the path you want to 

join it to.

2. Select the two end points to be joined.

3. Click on Join in the Object menu (or click on the Join button in the shortcuts), to join the two paths 
together.

The end points of the paths must be close enough to join.
You cannot join more than two paths together at the same point.
You can only join paths at their end points.

See also
Pointer tool
How to use the shortcuts
Shortcuts



Enter text

You can enter text directly into a picture.    You can also paste text from other applications into the 
picture.

How to enter text
1. Select the text tool.    The icon changes to an I-beam    -    .    Notice also that the shortcut bar at the 

top of the screen changes to display a text bar.    This contains text controls which enable you to 
format the text. 

2. Click the text tool on the picture in the approximate position you want it.    You can always move the 
text after you have entered it.

3. Enter the text you want.    To start a new line in the text, press ENTER.

4. Format the text, by highlighting sections of text and then using the text controls.    In this way, you 
can specify the font, size, spacing and general appearance of the text.

The text you have entered becomes an object in its own right - a text object.
The text can be edited after you have entered it.    Use the text tool to highlight the text you wish 

to alter, and then use the text controls.
You can opt to have both the shortcuts and the text controls displayed at the same time.    Click 

the right mouse button over either bar, and select Swap when editing text from the popup menu. 

How to enter text at an angle
You can change the angle at which text is entered. To do this:
1. Select the text tool.

2. To turn the text cursor clockwise, hold down ALT and press the right arrow key.
To turn the cursor counter-clockwise, hold down ALT and press the left arrow key.

3. When the cursor is at the correct angle, click on the work area and begin typing.

4. To return the cursor to the upright position, press ESC.
There are sixteen cursor orientations, so each time you press the arrow keys, the cursor moves 

through 1/16th of a circle, which is 22.5 degrees.
You cannot use this method to change the orientation of existing text: this must be done with the 

rotate tool.
When you move the cursor over text whose orientation has been changed (either by angling the 

cursor or by using the rotate tool), the cursor is shown at the nearest appropriate angle.

How to enter text in a text frame
Instead of simply typing onto the picture, in which case the text will extend to the edge of the workspace 
before starting on a new line, you can specify the area in which the text is to be printed.    You do this by 
first creating a text frame.
1. Select the text tool.

2. Click on the picture and drag.    An outline appears to indicate the position of the text frame.    When 
it is positioned correctly, release the mouse button.

3. Type the text.    Its width is limited to the width of the text frame. 

See also
Text tool
How to use the text controls
Text controls



Edit text

Once you have entered text in a picture, you can go back and edit it in any number of ways.

How to adjust the size of a text frame
A text object is displayed in a text frame, which is indicated by handles around the text.    Even if you 
have not specified a text frame, you will find that Design Studio has given a default one to the text.

You can change the size of the text frame to format the text differently.
1. Select the text object.    The text frame has both filled and clear handles.

2. Drag one of the filled handles to change the shape of the text frame.

3. The text is reformatted within the new-shaped frame.
The clear handles are used to space the text.
If you make the frame too big, the frame will shrink to a more appropriate size for the text 

contained in it.
 Drag and hold down SHIFT to stretch the text inside the frame, along with the frame.
Hold down CTRL and drag to stretch the text inside the frame, and maintain the aspect ratio, 

along with the frame.

See also
Pointer tool
Text tool

How to change the color of the text
1. Select the pointer tool.

2. Select the text object whose color you wish to change.

3. Click on Color in the Fill menu, and select the color you require from the drop-down color palette.    
Alternatively, if you already have the color palette displayed on the desktop, you can simply click on 
color you require.    

If you have given individual letters of the text a color, and then you select the text object and give 
the whole object a different color, the color of the individual characters will not be overridden.

See also

Color palette 



Use the text controls

Whenever you select the text tool, a set of text controls appears on the desktop.    These text controls 
are one-click buttons which enable you to perform common text functions quickly.    To use a text control,
simply select the text you wish to edit and click on the text control button you need.

How to move the text controls
The text controls can be moved around the desktop at your convenience.    To move the text controls:
1. Click the left mouse button on the background of the text controls and hold it down.

2. Drag the mouse across the desktop, and a rectangle representing the text controls will follow.    If 
you bump into the top or bottom of the desktop and release the mouse button, the text controls will 
stay at that edge.    If you release the mouse button in the middle of the desktop, the text controls will
float.

or
1. Click the right mouse button anywhere on the text controls.

2. A configuration menu appears: select where you would like to position the text controls.
Once you have positioned the text controls, Design Studio remembers this setting and will put the

text controls in the same place whenever you load the program, until you move them again.
The text controls can either replace the shortcuts or be displayed as well.    To toggle between 

these options, open the text controls' configuration menu and click on Swap when editing text.
Text controls apply only to the text which you have selected, apart from the left align, centered, 

right align and justified buttons, which apply to the whole text object.
You cannot apply a font to a whole text object, only to selected text.

See also
Text controls



Change letter, word or line spacing

You can change the letter spacing, word spacing and line spacing of a text object after you have created
it.

How to change letter spacing
There are two ways to do this:
1. Select the text object.

2. Point at one of the clear handles on the right or the left of the text frame.

3. Drag the text frame horizontally to adjust the spacing between characters.    Increasing the size of 
the text frame will increase the letter spacing, while reducing the size will decrease the letter 
spacing.

4. Release the mouse button when you are happy with the letter spacing.
As you drag, the pointer changes to an    A..B..C    shape.
As you drag, the information line indicates by how much you are changing the letter spacing.

or
1. With the text tool, select the text whose letter spacing you wish to change.
2. Click on the kerning text control to move the characters 1% closer together, or on the tracking text 

control to move them 1% further apart.    Click again to increase or decrease the distance by 1% 
once more.

How to change the width of characters
1. With the text tool, select the text whose character width you wish to change.

2. Click on the expand text control to make the characters 10% wider, or on the compress text control 
to make them 10% narrower.

How to change word spacing
1. Select the text object.

2. Point at one of the clear handles on the right or the left of the text frame.

3. Hold down the mouse button, then hold down SHIFT and drag the text frame horizontally to adjust 
the spacing between words.    Increasing the size of the text frame will increase the word spacing, 
while reducing the size will decrease the word spacing.

4. Release the mouse button when you are happy with the word spacing.
As you drag, the pointer changes to an    AB..CD    shape.
As you drag, the information line indicates by how much you are changing the word spacing.

How to change line spacing
1. Select the text object.

2. Point at one of the clear handles on the top or the bottom of the text frame.

3. Drag the text frame vertically to adjust the spacing between lines.    Increasing the size of the text 
frame will increase the line spacing, while reducing the size will decrease the line spacing.

4. Release the mouse button when you are happy with the line spacing.
As you drag, the pointer changes shape to indicate that you are changing the line spacing.
As you drag, the information line indicates by how much you are changing the line spacing.

See also
How to use the information line



How to use the text controls
Text controls
Text tool



Import text from other applications

You can import text from other Windows applications, e.g. Notepad, Write and other simple word-
processors.

How to import text from another application
1. Open the other application and cut, or copy, the selected text onto the Windows clipboard.

2. Open your Design Studio picture and click on Paste in the Edit menu (or click on the Paste button in
the shortcuts).    The text is pasted into the picture.

3. To edit and style the text, select it with the text tool.
Imported text is always given Design Studio's default font.

See also
How to use cut, copy and paste
How to use the shortcuts
Shortcuts
Text tool



Join text to a path

You can join text to a path to create some interesting effects, for instance, text on a wavy line, or on a 
spiral.

How to join text to a path
1. Create a text object.

2. Draw the path for the text to flow along.

3. Select both the text and the path.

4. Click on Join in the Object menu, or click on the Join button in the shortcuts.
The path the text is joined to can be an open path or a closed path.
If you try to join text which has a return character in it to a path, only the first line will be joined to 

the path.
If the picture is displayed in preview format, the path will not be displayed (unless you have set 

the path to be displayed.)

See also
How to work with points and paths
How to split a path
How to use the shortcuts
Shortcuts
Text tool



Change text on a path

You can still edit text which has been joined to a path.    You can also change the way in which the text 
object is joined to the path via the Text on a Path dialog box.

How to edit text on a path
1. Select the text tool.

2. Click on the text you wish to edit.

3. The selected text is shown crossed out, and the words appear upright in a box alongside, so that 
you can edit them more easily.    Once you have finished editing, click elsewhere on the desktop, 
click on another text object or press ESC, and the text will be redrawn on the path.

How to change how text is displayed on a path
1. Double-click on the path to display the popup menu and select Object Info from the popup menu to 

display the Text on a Path dialog box.    Alternatively, you can select the path and then click on the 
Object Info button in the shortcuts.

2. Decide how the text is joined to the path, whether the path is displayed, what direction the text 
should flow in, how the text should align with the path, e.g. Top, 1/2 x-height etc., what text 
orientation you need, and make these changes in the dialog box.

3. Click on OK.
You can also use the Text on a Path dialog box to separate text from a path; click on the 

Separate check box and the text and path will become two objects again.

See also
How to enter text
How to edit text
Text tool
How to use the shortcuts
Shortcuts



Manipulate text

You can transform text, using the transform tools, in the same way as any other object.    For example, a 
selected text object can be scaled, rotated, skewed or reflected.    You can ungroup text.    You can also 
give text colors, fill styles and line styles.

How to transform text
1. Create or select your text object.

2. Select the transform tool you require.

3. Click and drag the tool to perform the transformation, or use the tool's dialog box.

4. When the object is in the correct position, release the mouse button.
Transforming text does not convert the text to graphics, even though its appearance may change 

dramatically.
Once the text has been transformed, you can still edit it.
Interesting effects can be achieved by transforming text, e.g. you can create mirrored text or 

inverted text.

How to edit transformed text
Transformed text can be edited in place.
1. Select the text tool.

2. Highlight the text you wish to edit.    If the text is very distorted (i.e. the angle between the baseline 
and the insertion point is less than 45), it is shown crossed out, and the words appear upright in a 
box alongside, so that you can edit them more easily.    You can then use the text controls to edit the 
text.

3. Once you have finished editing, click elsewhere on the desktop, click on another text object or press
ESC, and the text will be rewritten transformed as before.

How to convert text into a path
1. Select the text object.

2. Select Ungroup in the Object menu, or click on the Ungroup button in the shortcuts. Each character
is converted to a path, and is selected.

You can now select individual characters and manipulate them as you would any other path.

How to give text lines, fills and colors
You can give text the attributes that you can give to any other object.    You specify these attributes as 
you would with any other object.

See also
How to enter text
How to edit text
How to use lines, fills and colors
Text tool
How to use the shortcuts
Shortcuts



Display and use the color palette

You can have a color palette open on your screen which contains all the colors available.    You can turn 
this palette on and off, and you can add colors to it.

How to display the color palette
Click on Color Palette in the View menu, or on the Color Palette button in the shortcuts. To close the 
color palette, select the Color Palette command again.

How to edit a color in the palette
1. Double-click on the color you wish to edit to display the Edit Color dialog box.

2. The color you have chosen to edit is shown in the preview box.    Drag the slider controls and click 
on the color buttons to mix the color you require.

3. Click on OK, and the edited color is put into the palette and replaces the color you originally chose.
Any objects which were colored with the color you edited will be re-colored with the new color you

have created.

How to add colors to the palette
1. Click on the + button in the palette to display the New Color dialog box.

2. Drag the slider controls to mix the color you require, and click on the color buttons to create main 
colors.    The color you have mixed is shown in the preview box.

3. Click on OK, and the color is added to the palette.

See also
How to use the shortcuts
Shortcuts



Give an object a line or fill style

You can give an object a line style and/or a fill style.

How to give an object a line style
1. Select the object you want to style.

2. Select Popup Lines from the Line menu (or click on the Popup Line button in the shortcuts) to 
display the Line Style dialog box.

3. Select the line style you want from the list.

4. Customize the style by selecting the width of the line, and its end and join styles.    For more 
information on these options, use the help on the Line Style dialog box.

5. Click on OK to apply the new line style.

How to give an object a fill style
1. Select the object you want to style.

2. Select Popup Fills from the Fill menu (or click on the Popup Fill button in the shortcuts) to display 
the Fill Style dialog box.

3. Select the fill style you want from the list.

4. Customize the style by selecting the color and (if you have chosen a graduated fill style) the "to" 
color.    For more information on these, use the help on the Fill Style dialog box.

5. Click on OK to apply the new fill style.
You cannot apply fill styles to open paths.    You must close an open path before you can fill it.
If you have multiple objects selected, the line or fill style will be given to all the selected objects.
You can apply a no-line or no-fill style to the selected objects by selecting None in the Line or Fill

menus.
The line or fill style you create will be used as the default for any subsequent objects you create.
A fill style applies to the whole of a text object, but you can give individual characters a different 

color.

See also
How to use the shortcuts
Shortcuts



Color an object

You can give objects colors. 

How to color an object
1. Select the object.

2. Click on Color in the Fill menu to display the drop-down color palette and click on the color you 
require.    Alternatively, if you already have the color palette displayed on the desktop, simply click on
the color you require.

3. The object you have selected, for example, a path, image, or text, is given the color you have 
chosen.

If you have selected a graduated fill style for an object, you can change the "from" color by 
clicking on the color palette, and then change the "to" color by holding down SHIFT while you click on the 
palette.



Create a new color

You can create countless colors to include in your picture and add to the color palette.

How to create a new color
1. Click on the + button in the color palette to display the New Color dialog box.

2. Drag the slider controls to mix the color you require, and click on the color buttons to mix in some of 
that color.    The color you have mixed is shown in the preview box.

3. Click on OK, and the color is added to the palette.

See also
How to use the shortcuts
Shortcuts
How to color an object



Use cut, copy and paste

You can use the Windows clipboard to copy pictures, text and graphics between different applications 
and between Design Studio pictures.

How to copy an object from one picture to another
1. Select the objects you want to copy to another picture, and click on Cut or Copy in the Edit menu 

(or click on the Cut button or the Copy button in the shortcuts).

2. Open the second picture.    You will be asked if you want to save changes to the first picture, which 
is automatically closed when you open a new one.    Alternatively, you could run a second copy of 
the program.

3. Click on Paste in the Edit menu (or click on the Paste button in the shortcuts).

4. The object is pasted into the target picture.
An object can be cut from and pasted into the same picture.    To copy within the picture, we 

suggest you use the ALT key when you drag the object, rather than cut the object to the clipboard.
You can copy as many or as few objects as you want to in one cut and paste operation.
Cut removes the object from the original picture and places it in the clipboard.    Copy just makes 

a copy of the object and leaves the original untouched.
Cut has the shortcuts SHIFT+DEL and CTRL+X.    Copy has the shortcuts CTRL+INS and 

CTRL+C.    Paste has the shortcuts SHIFT+INS and CTRL+V.

How to copy objects from one application to another
1. Open Design Studio and the other application, e.g. Windows Notepad.

2. Select the objects you want to copy in Design Studio and click on Copy in the Edit menu (or click on
the Copy button in the shortcuts).

3. Move to the other application and Paste the object into the other application.
If the other application does not recognize the objects you want to copy, the clipboard will not 

paste them in.
If you paste an object from another application, compatible line and fill styles and colors are 

copied to the current picture.    Compatible colors will be added to the color palette.
You can paste text from another application into a picture.

See also
How to use the shortcuts
Shortcuts



Delete an object

You can remove an object from a picture without copying it to the clipboard.    This is useful when there 
is something in the clipboard that you do not want to lose.

How to delete an object
1. Use the pointer tool to select the object you want to delete.

2. Click on DEL.    The object is removed from the picture and cannot be recovered from the clipboard.



Import an image

You can import a number of different image formats into your picture, either for display or for autotracing.

How to import an image
1. Click on Import in the File menu to display the Import from File dialog box.

2. Select the type of file you want to import in the List Files of Type list box.    The files of that type are
displayed in the File Name list box.

3. Select or type in the name of the file to import, and click on OK.

The available image file formats are:
.TIF - TIFF bitmaps, and TIFF parts of EPS files
.PCX - PC Paintbrush images
.IMG - GEM image files
.BMP - Windows DIB bitmaps

If you are running Windows 3.1 or later, you can also drag an image and drop it into Design Studio using
the Windows File Manager.



Autotrace an image

You can autotrace images that are imported in much the same way as you would trace a picture with 
pencil and paper.    This creates an object, or group of objects, that looks like the original image.

How to autotrace an image
1. Import the image into the picture.

2. Select the autotrace tool, and click on, or near, the edge of the image.

3. A path is drawn around the image.    If a fill style is selected, the path will be filled.
If you click and drag the autotrace tool across a section of the image, then only part of the image 

will be autotraced.    This always creates an open path.
Not all images will autotrace well.    A high-contrast, well defined image will autotrace well; a low-

contrast image will not autotrace well.
You can adjust the accuracy of the autotrace tool by double-clicking on the tool icon to display the

Autotrace dialog box.

See also
Import an image
Autotrace tool



Color an image

You can give one or two colors to an imported image.

How to give one color to an image
1. Select the image.

2. Select a color from the color palette.    The image is redrawn in the selected color.

How to give two colors to an image
1. Select the image.

2. Give the image a graduated fill style that involves the two colors you want to give the image.    The 
foreground of the image is colored with the "to" color, and the background is colored with the "from" 
color.

See also
How to use lines, fills and colors



Import a line-art graphic (metafile)

You can import a number of different metafile formats to display, ungroup and manipulate.

How to import a line-art graphic
1. Click on Import in the File menu to display the Import from File dialog box.

2. Select the type of file you want to import in the List Files of Type list box.    The files of that type are
displayed in the File Name list box.

3. Select or type in the name of the file to import and click on OK.
An imported graphic is displayed as a group of objects.
Line-art graphics cannot be autotraced.
To smooth an object during import, select Smoothing before clicking on OK.    Use smoothing if 

you are likely to ungroup the object you are importing.
If any imported attributes are not recognized, then they are given defaults.

The available line-art file formats are:
.CGM - Computer graphics metafile
.GEM - GEM metafile
.WMF - Windows metafile
.EPS - Encapsulated PostScript EPSF

If you are running Windows 3.1 or later, you can also drag a line-art graphic and drop it into Design 
Studio using the Windows File Manager.



Export images and line-art

You can export objects and whole pictures in a number of different formats.
You should cut, copy and paste graphics via the Windows clipboard wherever possible when 

copying between Design Studio pictures or between applications.

How to export images and line-art
1. Select the objects you want to export.

2. Click on Export in the File menu to display the Export dialog box.

3. Select a file format from the List Files of Type list box.

4. Select the check boxes in the dialog box as required.    For more information, use the help on the 
Export dialog box.

5. Type in the name of the file you want to export to, and click on OK.    The selected objects are 
exported to the filename in the specified format.

If your picture contains any bitmaps, you must export in one of the bitmap formats.

You can export as the following types of bitmap image:
.TIF - TIFF bitmaps
.PCX - PC Paintbrush images
.IMG - GEM image files
.BMP - Windows DIB bitmaps

You can export as the following types of line-art:
.CGM - Computer graphics metafile
.GEM - GEM/3 or GEM/4 metafile
.WMF - Windows metafile
.EPS - Encapsulated PostScript EPSF
The file extension is added if you omit it.



Print a picture

You can use the printing process to print artwork on your local printer, or to print a picture to disk for 
printing later or elsewhere.

How to print a picture
1. Select Print in the File menu to display the Print Options dialog box.

2. Select the print options you require, e.g. to disk, multiple copies, scale, reversed, tiled, landscape 
etc.    For more information on these options, call up help from the Print Options dialog box.

3. Click on OK to display the Printing dialog box.
The Printing dialog box identifies the file you are sending, and to which printer you have sent it, 

and indicates how much of the picture has been sent.
To stop the printout for any reason, click on Cancel in the Printing dialog box, or press ESC.
If part of your picture seems to be missing, check that all the picture appears within the dotted 

blue hair-line that represents the printable area of your current page.



Change your printer

You can specify which printer your picture should be sent to.

How to change your printer
1. Select Printer Setup from the File menu to display the Printer Setup dialog box.

2. Select the printer you want to use from the list of available printers in the list box.

3. Click on OK.    The new printer will remain selected until you change it again.
The same Printer Setup dialog box can be displayed by clicking on Printer Setup in the Print 

Options dialog box.
You can select Setup... from the Printer Setup dialog box to display the printer specific setup 

dialog box.    These dialog boxes originate from the printer driver.
If you need to use a new printer which is not listed, you should install it from the Windows 

desktop.






